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Introduction
Overview
This tutorial describes the basic operation and typical use of BoardModeler Lite. It is designed

for first-time users to become familiar with the common commands and to gain experience of
using BoardModeler Lite in a typical design flow with CADSTAR.

Further Information
For further detailed information on the topics covered in this tutorial, please refer to the on-line

help provided within the application. This can be accessed via the Help / Help BoardModeler...
menu option or by pressing the F17 function key.

Conventions and Terminology Used In This Document

The following conventions and terminology are used throughout the tutorial document

¢ Commands, menu options or user interface operations are shown using bold italic text,
for example, Tools / Options

e Names of file system objects (file paths, file names, folder names etc.) are shown in italic
text surrounded by single quotes, for example, ‘C:\BML Training\BM\_Project’

e Any values or settings that must be entered into the BoardModeler Lite user interface by

typing text are shown enclosed in double quotes, for example, “0.5”. Note that the
quotation marks should not be entered as part of the text input.

e Throughout this tutorial, the ‘BoardModeler Lite’ application name is usually abbreviated
to ‘BML.

e This Symbol indicates an HTML link to a demonstration video. This icon will appear

Eﬂ frequently throughout the tutorial. An internet connection is required to see the videos.
They are best viewed with Internet Explorer (c) 9.0 or newer and Firefox (c) 3.0 or newer.

Software Tools Used By This Tutorial

This self-teach tutorial guide requires the use of the following tools:

e BoardModeler Lite 7.1
e CADSTAR 12.1 or later
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What is BoardModeler Lite?

BoardModeler Lite (BML) provides a powerful design environment to bridge the gap between electronic
(ECAD) and mechanical (MCAD) design. BML is a tool for use by the PCB designer, to combine the two-
dimensional (2D) board design data and the three-dimensional (3D) mechanical design data in a single
environment. It also allows for easy exchange of data between the electronic and mechanical domains.
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BoardModeler Lite
BoardModeler Lite addresses the following main functional areas:
« 3D Representations for Electrical and Mechanical Parts

BML provides the functionality to import the 2D CADSTAR PCB design data and 3D mechanical design
data and to combine it in a single environment. It is able to display realistic 3D models to represent all
aspects of the design, such as the board outline, PCB layers, electronic parts mounted on the board
and a mechanical case or chassis. This is all presented in a single window and allows the user to view
the data in 3D, from any required viewpoint.

e Clearance and Collision Checking
BML provides the features to check a design (either interactively or in batch check mode) for collisions
between components mounted on the board and between the components and board shape and any

enclosing mechanical constraint (e.g. a case or chassis). It is also possible to measure sizes of design
objects and measure the clearances between them.

e Back-annotation of Design Changes from 3D to 2D
BML allows changes made to the component placement in the 3D environment to be passed back to

the 2D CADSTAR PCB design. This also covers the ability to pass initial board outline shape, critical
component placement and keep-out or height limitation areas, supplied by the MCAD department, into

All of these areas will be covered in this tutorial.

the 2D CADSTAR PCB design.
\ M ZUKEN
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Data File Structure for BoardModeler Lite

The design data used by BoardModeler Lite is stored in a defined folder structure in the file
system on disk. The location and naming of these folders is set up in BML on the Project tab of
the Tools 2Options dialog (as shown in the image below).

The location of the Document root folder is set during the software installation process (the
default location is ‘C:\DOCUMENT) but this can be changed later through the Tools >Options
dialog. However, it is important to note that these locations can only be changed when no
Project data is loaded into BML. Also note that if you do not have ‘Administrator’ privileges you
will need to first select the Private option on the Tools 2 Options dialog in order to be able to

modify the folder paths.
x|
Document Root Folder
Configration file type * PRecommended " Private

This is the main folder that contains all Praject | Golor | Graphics | Operation | Other |

design data relating to BML. When this Document root folder = §|CA\DOCUMENT _l
location is defined the following four sub- Praject root folder : IE\DEICLII\"IEI»I'I'\BM\_Prmect [
folders will be created automatically inside Lz ot Gl ¢ [CDOCUMENT\BM ' Library _|

a folder called ‘BM’ in the Document Root

¥ Save EML project in the same location as the CADSTAR desien:

Folder.
- Part library folder titles
_Project Level 1: |_Parts (Level 1 (simp Level 2: |_Parts {Level 2)
_Library Level 3: |_Parts (Level 3) Lewvel 4 : |_Parts (Level &)
—Interface Level 5 : I_Parts (Level &) Level G : I_Parts {Level & (preci
_Resource

—Interface for mechanical CAD svstems

Project Root Folder
Element matching file (C3W) : I _I

This folder is used to store data for
individual projects created in BML. The
default location for this folder is
‘<Document Root Folder>\BM\_Project’,
although it can be changed to a different
location of your choice.

Mote : Setting available while no projects are opened.

Apply | Cloze I

Library Root Folder

This is the folder that is used to store the 3D model data to be used to represent how the
components (parts) will be viewed in BML. The default location for this folder is

‘<Document Root Folder>\BM\_Library’, although it can be changed to a different location of your
choice.

Underneath this folder are six separate folders (‘ Parts_1’to ‘ Parts_6’), which allow 3D models
of up to six different levels of detail to be used to represent each component. The required level
of detail to use for display can be chosen from within BML. This will be covered further later in
the tutorial.

Save BML project in the same location as the CADSTAR Design

If the option is enabled, then BML will attempt to load and save data into the same location as the
corresponding CADSTAR PCB design file. BML will create a folder of the same name as the
design and will write its design file <design_name>.bma alongside the CADSTAR PCB file. In this
case, any setting for Project root folder is ignored.
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The behaviour is different depending on whether BML is started from within CADSTAR (from the
Tools menu) or from the Windows Start menu. Even if the new option has been selected, if BML
is started from the Windows Start menu, it will still be necessary to browse to the required
location from which to load existing data or save a new project. If the option is not set, then BML
will behave as before.

If you have existing BML project data which you wish to re-locate along-side the corresponding
CADSTAR data, then it will be necessary to run BML from the Start menu, load the existing
project data and then save it in the new location (using File / Save as / Project...) before the new
option is enabled — otherwise BML will not be able to find the existing data and will create a new
project from scratch.
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Task 1 - Configuration Set-up for the Tutorial

This tutorial expects the design data to be located in a folder called ‘C:\BML Training’ and so we will now go
through the steps necessary to configure BML to access this data. To begin, ensure that you have extracted
the tutorial example data from the zip file (‘BML Training.zip’) supplied with the tutorial into ‘C:\BML Training’.

Note: If you choose to put the example data in a different location, you will need to substitute all the file paths
in the following tutorial to match the actual location of the data.

Now perform the following steps.

1. Select All Programs->BoardModeler Lite ?BoardModeler from the Windows Start menu.
BoardModeler Lite will run up.

.h:' BoardModeler Lite
File Project View Library | Tools

2. From the main menu bar select Tools 2Options to display the Window

BoardModeler Options dialog and ensure the Project tab is IS8 Options...
active. R fssociate board,.,
Assembly | Library | EDA LF | IDF I/F |

3. Specify the folder locations as x|

shown in the image. Note that once Configration file type f+ Recommended ™ Private
you have entered the path for the _
Document root folder and clicked the Project | Golor | Graphics | Operation | Other |
[Apply], the paths for Project and —

. . [ troot falder:  [CABMLT |
Library root folders will be set BEIMEE (agk ey | rana
automatically. Praject root folder : IC:\BML TrainingsBh'_Project |

. .. , Library root folder : CABML TraininghBbkd%_Library

If you do not have ‘Administrator I —I
account privileges on the computer, [~ Sawe BML project in the same location az the CADSTAR desiant
make sure that you select the Private
option to enable the folder paths to be - Part library falder titles

modified. Level 1: I_Parts [Level 1izimp Level 2: I_Parts (Level 2
Level 3 : I_Parts {Level 3 Level 4 : I_Parts {Level 43
The above operations will direct Level 6: |_PE-rtS (Level 5) Level 6 : |_Parts (Level B (preci

BoardModeler Lite to access the folder
structure as shown in the image below. ~Interface for mechanical GAD systems

= [ BML Training Element matching file (CSW) I |
I _Temp

%_}m MHote : Setting available while no projects are opened.
= _Interface

+ I _Library
+ ) _Project
) _Resource
H ) CADSTAR

The example CADSTAR data which will fpply | Close |
be used during the rest of this tutorial is
located in the ‘CADSTAR’ folder.
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In order to make sure that you can match the operations described throughout the following tutorial,
ensure that the settings on each tab of the Tools>Options dialog are set as shown in the following
images. The most important settings are highlighted with a red border.

Gontigration file type

[ Swstem GUI

i+ Recommended

Project  Color IGraphlcsl Operation | Other |

BoardModeler Options

" Private

Backeround
Highlight
Base plane

Cutting plane :

Common :

[ ] Top gl it

om

r PreSelect Selsct Measure:
Plans Grid

. Plane: Grid |

[l Gappine p\ana
[ Edees il
|| Temporary

jcoor |
Il _ el
im0l |
EEEN
EEEN
EEEN
mCE[]
rrrr
rrrr
Custom Colors >> |
Cancel

PGB Elements

[ Prior color set in 3D models

] Fart | B Board | [ Mechahole |
[[  Wahole | [T Condutor | [T Mask pattern |
[ Symbol mark | [T Keepinfout | [ Height limit |
[ Document | W Wiring carrier |

Mecha Elements
’ll

Mechanical parts ‘

BoardModeler Options x|

Configration file type % Recommended " Private

Project | Colar | Graphicg  Operation IOther |
— Mouze operation

= BM original
Qrbit

¥ EM Checker/CADSTAR 3D

y and drag

Press rlghl + Ctrl key and drag

Press center + Cirl-key and drae
upward : zoom out, downward © zaom in

Pan
Zoom In/Out

— Shartcut Kews

BoardModeler Options x|

Contigration file type @ Recommended " Private

Project | Golor  Graphics |Operamn | Other |

Driver type

OpenGlL A

i~ Performance tuning

Approximate accuracy loww hd

[¥ Enable display list
¥ Display de-clutter threshold

~ During view operations

[¥ Display de-clutter threshald
@ All desien objects

Al except shapes of baard and components
l Geametry dizplay simplification I

" Force wireframe view

I~ Select tag

|V Pre select tag

I~ Display marker ior nvisible part; —

small laree

Transparent =

Rendering of wiring carrier

Apply | Cloze I

Reset All

Gzt
I File hd Citrl+N
Command Mew Key
Mew Praoject... - Ctrl
FCE i
Library model I~ Ak
Open Praoject..
P ; [~ Shift
30 model .
Library madel
GClose Project o
Save Project
Save as Project
Clear fssien I
Delete Project
CADSTAR Impnrt LI D_I
e I elete

Apply | Close I

4. Click the Apply button followed by Close.

5. Select File 2Exit to close down BoardModeler Lite

End of task

BoardModeler Options x|

Canfigration file type * Recommended " Private

Projest | Golor | Graphios | Operation Other |

Resource

Language : |Enelish =

Mote : Restart tool for switching resource settings.

I ¥ Open automatically after importing the PGB I

Gleat loe

[ Retrieve instance name

I~ ifoe outp

W Do not allow parts to be moved off the board surface (in the Z-axis)

[~ Check. if parts are moved outside of the board outline

Apply

Close I
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Task 2 - Basic Operations — Becoming Familiar with the U.I.

In this section we will take an initial look at BoardModeler Lite and become familiar with the different
areas of the user interface and how to perform such common operations as selecting objects in the
design or changing the view of the design (i.e. rotate, pan and zoom, setting colours etc.)

Start by running up CADSTAR and then load the Basic Operations workspace (‘BasicOperations.csw’)
from the ‘C:\BML Training\CADSTAR\Self Teach’ folder.

1. From the CADSTAR Tools menu, select the Board Modeler... option. Select OK to confirm the

dialogs that appear. e
Settings  Libraries .Iools | Window Help
) Cu i’ o @ Reports 3] IE‘ 1
EI _‘ % Cutout Report Generator 3 ] n %
_X 4 /m :‘,:j Embedded Place and Route ;rations.p(
. E Auto Router...
ag;' [ | PrEditor XR...
lBML = | PrEditor XR HS... x|
[ | st verty.. '3@' Transfer this job to Board Modeler?
ﬁ Board Modeler... o
s | Field Solver... Cancel
L | % Adviser...

Note: If you have already run all or part of the tutorial before, you may see two further dialogs prompting
for permission to overwrite the existing data. Select OK and then Yes in these dialogs.

Importing PCB data from CADST) x|

A PCB data was detected. (BasicOperations)
' Do you allow to overwrite it?

x

@ % The CPAfile forthis design already exists.
'.\ /.‘ It will be overwritten.

Cancel |
Mo | Cancel |
: x|
2. Set the options as shown >
CPA path : |C:\BML Training\C.-’-\DSTAF!\SelfTeach\Basicherations.-;I
Enter :Top Placement” as the name of the 7 Update DA UF

CADSTAR layer that contains the default 2D

. . . . Simpl t sh, ti
component geometries that will be displayed in L ——
3D within BML Geometry layer : Top Placement
Replace geometry of components
Alternatively you can enter Top Silk or Top © 0 2
Assemb'y_ = With Library of BoardModeler
Precizion level : ILeveI 1 ;I

3. Select [OK] Height attribute : I

— 30 Model Mame
Library 10 : + Component Mame { Reference+Alternate )

 Part Name

 Attribute I
— Simplification

[V Import pads

|+ Import inner lavers

Conductive : ISD Shape Yl

¥ Import netlist
| Import tracks

¥ Import copper items

[~ Set board thickness : II_EIEIDD mm

QK I Cancel I

MZUKEN
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BML will first convert the CADSTAR CPA file into the necessary files for BML to read. It will generate a
log of operations as it does this and should there be any Warnings or Errors reported, it will offer the
chance to view this log file.

— Translation Log (BasicOperations.cpa) | E
TranSIation is completed' I J0B.000000."Loadina techneloav & resources", | b]
ERR.20037."Proicct resource reader failed.1
RN "Mechanical exoort resource reader failed.".l
s (al "Librarv replacement resource reader failed.",|
\_!l) Wiould you like to check process log? 05 poading laver information from CPA™.1
[ O BADIN % s racked EEms destan datar
08, PCB desian to 3-D data".Board."BOARD"|
0B PCB desion to 3 VA
es Mo | 8 . 35 s un:n - v:l.':l'rnn Elm:[err;e
o PEE deetan tn 31 ey el on il
o DER sston tn 31 ey Lo Eleg
0B! PCB desian to 3 wer “Bottom Elec”
08, PCB desian to 3 wver."Bottom Solde
. . L ' o5 CE doctan in 31 e oo Eact
You can select No to continue without viewing the log file. 08, PCE dosian to 31 ver. Bottom Place
. . .. 0B, PCE desian to H wer.“Bottom Elec
Selecting Yes will show an output similar to that shown here. If o0 P desion tn 1 e Dackaec e 07000
you display this report, select OK to dismiss it and continue to | s PC5 desiana 15 e Packase D
. . 0B PCB desian to 3
load the design into BML. T Spb nh s
0B.| "Undatina extracted PCB design data",,|
08.| 'Creatina BM proiect™..l
END.'"We: lav 20 15:07:41 2009"1
. . . 'COMPLETE,0000011 =i
BML will then continue to load the design and create the =
necessary graphics data to be displayed by the application.

The PCB design will be automatically opened for display in BML and should look similar to the image on
the next page.

Eﬂ The User Interface

The different sections of the BML user interface are shown labelled in the image below and you
should spend a few minutes to acquaint yourself with the different areas and their names. They will
be referred to throughout the rest of this tutorial.

T o S v—— (=13}

File Project View PCB Lbrary Tooks Window Help
radH e sReeaE |8 Menu bar Tool bar

Aesembly | Library | EDA IF | IDF I/F |

P Besrperatons
201 Aesartly Ao 3D Model
L] _Document el 2

-§P BasicOperations r5 | Parts | Machanical parts | Nets | WES | Tool bar
Rendering of parts:  [Default -

T ET T == [ed Graphics Window

Top Placement Keep-infaut Top Elec

SEIRE nd |

<

Top Assembly Keep=in/out Top Elec
Top silk. Symbal Top Elec
Top Solder Resist | Masking  Top Elsc
Top Elec Conductor  A-side
Bottom Elec Gaonductor  B-side
Bottom Solder Resist| Masking Bottom Elec
Bottom silk Symbaol Bottom Elec
Bottom Assembly | Keep-inout Bottam Elec .
Bottom Placement | Keep-infaut Bottom Elec Graph ICS

BOARD_FIGURE Board Lawer irrelevant

i th T Panel

Project
Browser

LRI

Control
Panel

PErE N B8

Measurement Histary Panel |

[ pesicoperations

For Help, press F1 |Optional parameters File was saved succssshully 4
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Manipulating the Display

=7

Using the Standard Views

BML provides a number of toolbar icons to quickly switch between different, pre-set views on the
design. These cover the standard 2D views (top, bottom, front, back and both sides) in addition to 3D
‘Isometric’ views of the top and bottom of the board.

0O BEOBO G

4. Hover your mouse cursor over each icon to see the tooltip which describes its function. Experiment
with the different toolbar options to see the effect on the graphics display. Select the top (A-side)
Isometric option when you have finished, return to the standard 3D view.

..:' BoardModeler Lite - BasicOperations
Note: The same functions are also available from the View  File Fraject | view PCB Library Tools Window Help

- Orthogonal view menu if preferred. v Project browser
Toolbar »
v Document selector
v Status bar
Measurement history

Dimension unit 4

Orthogonal view
Projection mode 4

5. If you would rather see the 3D view as a perspective 7 :'OEEE’“’“SE’ X

projection (rather than orthographic) you may select -
this option from the View->Projection mode menu. : m:ztr s

Measurement history

Dimension unit
Orthogonal view
Projection mode
Scene rendering
Visibility

L3

Orthographic Perspective

Changing the Scene Rendering Mode

In a similar way, BML provides a set of toolbar icons to quickly switch between different, ‘scene rendering’
modes. These offer ‘Shaded on Wire’, ‘Shaded’ and simple ‘Wireframe’ views.

@ ® & |

\ M ZUKEN
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6. Experiment with the different modes by selecting the icons from the toolbar or from the View / Scene
rendering menu option.

The scene rendering mode chosen will have an impact on how much CPU resource is required to
manipulate the display (when rotating, panning or zooming, for example) and it will also affect which
features of the design data can be selected. These differences are summarised in the following table.

Icon Rendering Mode Performance Selection
Shaded on wire
] Slow
— (especially with All
large designs)
Shaded
Surfaces are
) Medium selectable, but
. not edges
Wireframe
No surfaces are
3t Highest selectable — only
T edges
It is also possible to control the rendering mode individually [l
for each object in the design (e.g. parts, board, mechanical  Lavers |Parts | Mechanical parts | Nets | oS |
constraint, etc.), and in these cases it is possible to select a  Rendering of parts: | Default =]
‘ , . i ’ - Default
transparent’ rendering mode and a ‘hidden’ mode (where Wiew Shaded on wire [
the selected object is not displayed at all). We will return to P v |Top Plac%ﬁfedffadme ut Top
this feature later in the tutorial. | 2| v Top Assyp 1) Too
3| & Topsik[Hde Top
! 4+  Top Solder Resist task ing Top
[} s Trm Flar CimndLeter A—cis

You may change the rendering mode for all
parts in the design with one operation. At the
top of the Control Panel in the Graphics
Window, there is a drop-down list box which
allows the different rendering modes to be
selected. The image to the right shows the
effect of selecting the ‘Transparent’ mode.

\ M ZUKEN
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7. See the effect of the different modes by selecting the options from the drop-down list in the Control
Panel. When you have finished, restore the display by selecting the ‘Default’ option from the list.

Changing the view — Pan, Zoom and Rotate (Orbit)

BML provides a set of toolbar icons to invoke commands to change the view of the design in the graphics
panel. These include standard 2D pan and zoom operations, but also a 3D rotate (or ‘orbit’) function. The
full list of available commands is listed in the table below.

Note: selecting the Rotate, Zoom, Pan or Frame icons will set a ‘mode’ that will continue to be active until
another command is selected. Pick the Select icon x from the top of the 3D Model Toolbar or press
the ‘Esc’ key to cancel these commands.

If you use the Mouse Tool short-cuts instead, then these operations (Rotate, Zoom and Pan) can be used
at any time (even during the execution of other operations — for example, the Move command) and the
tools are only active while the mouse keys (in combination with the ‘Ctrl’ key) are pressed.

Icon Meaning Mouse Tool
. Drag while pressing both ‘Ctrl’ key and the
@ Rotate (Orbit) left mouse button.

Zo0m Drag while pressing both ‘Ctrl’ key and the
Gy middle mouse button. Drag upwards to

S zoom out and downwards to zoom in.
Drag while pressing both ‘Ctrl’ key and the
& Pan right mouse button. Drag in the direction in

which you want to pan the design.

1

o) Zoom by area
—— (select the area to be displayed)

] Zoom Selection

(zoom to show selected object)

03, Zoom to Extents
] (zoom out to display the entire design)

Re-center
[we (pans the display so the selected object

is at the centre of the screen)

The Zoom Selection and Re-center icons are only available when an object is selected in the
graphics panel.

8. Experiment with these icons to see how they operate and get used to manipulating the view of the
design. You can use these operations in combination with the rendering mode commands (see
above) to explore different views of the data.

Tip: Use the View All icon to bring the entire design back into view in the graphics panel at any stage if
you get lost!

14
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It is possible to cycle backwards and forwards through previous views of the design using the
Back and Forward icons on the toolbar. s

9. When you are satisfied that you are familiar with these operations, perform a View All command then
chose the Select icon from the 3D Model Toolbar.

End of Task.

\ M ZUKEN
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=l Selecting Objects

Design items can be selected in BML in several ways. They may be selected individually by clicking on
them in the graphics panel, multiple objects may be selected at once by drawing a selection rectangle
around them and items can be selected in the Control Panel (on the left of the Graphics Window), which
will then be highlighted in the Graphics Panel.

The type(s) of item which will be included in any selection is governed by the current setting of the
Selection Filters and these are displayed as a row of icons at the bottom of the Graphics Panel.

PN ) B85

The name and meaning of each filter is explained in the following table.

.....

Mask Pattern

Icon Filter Description
' Board Allows the PCB board itself to be selected
Allows any holes (representing vias or
Hole .
component pins) to be selected
i Conductive Allows routes/tracks and copper areas to be
e Pattern selected
i This option is not currently relevant for BML —

please ignore.

Symbol

Allows the silkscreen pattern from within the
component footprint (if any) to be selected

Component

Allows the components (parts) themselves to
be selected

Restriction Area

Allows restriction areas included within the
component footprint to be selected (for
example, placement shapes)

® B

Height
Area

Limitation

Allows any height limitation areas defined in
the design to be selected

-
b=
u

Mechanical Part

Allows any mechanical parts (also known as
‘constraints’) imported into the design to be
selected

Document This option is not relevant for BoardModeler
=N Lite — please ignore.
) WCS Allows any WCS origins (working coordinate
system) to be selected
Chassis This option is not relevant for BoardModeler

Lite — please ignore.

MZUKEN

16



http://www.zuken.com/cadstar
http://www.zuken.com/
http://www.zuken.com/
http://www.zuken.com/movies/cadstar14/CADSTAR_BML_Selecting_Objects/CADSTAR_BML_Selecting_Objects.html

\ M ZUKEN

Task 3 — Selecting objects

Try the following examples to get used to the different ways of selecting items within the design.

1.

Ensure the Board and Component filters are active (click the icons ] i A =it I
so that they look as though they have been pressed in). -

Hover a component in the Graphics Panel. The object changes
to the pre-select color, in this case Yellow.

Select a component in the graphics panel using the left mouse
button. The selected component will be displayed in the ‘Select
color

x
The Pre-select and Select colors can be Configration file type % Recommended ! Private
changed in the Tools >Options [Color] tab | Graphios | Operation | Ot |
dialog' System GUI

Backeround ; To | Battam I

Highlight : O PreSeIectl [ Select | Meazure |

s S Flane [] Grid |

Hold down the <Shift> key on the keyboard and click on some
different components. Notice that they are added to the
selection set and also drawn in the ‘Select color.

While still holding down the <Shift> key, click on the PCB board

in an area where there are no components. The board is also

added to the selection set.

Now click on the background of the graphics panel where there "
are no design items. This will clear the current selection.

In the Control Panel (to the left of the Graphics  |s= = it 12>
Panel), make sure that the Parts tab is

displayed and try selecting a row of the table
(for example, the one corresponding to LED1).
The corresponding component will be
highlighted in the graphics panel in the ‘Select
color.

D1 dio-045001 854cia35-1011
D2 dio-D45001 854ia35-1011
TR2 ta02

TRI 1092

o1 cep-diallss (1200)

o2 cep-diall55 (1200)

R3 res-07000250(mrs25-12
R4 res-07000250 {mrs25-12
Ri res-07000250 (mrs25-12
R2 res-07000250(mrs25-12
LED1 led-diall300(1254)

LED2 led-diall 30002543
WGCRY|  TESTPOINTGon-soldere
AGND | TESTPOINTEomsoldere

El SRR AR EE R

\ M ZUKEN
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8. To select a range of components (e.g. from C1 down to R2), first click on the C1 row in the table then
hold down the Shift key and click on R2. All the components in-between will also be selected and
highlighted on the display.

Note: If you select components by clicking on the design in the graphics panel, the corresponding rows
in the table on the Parts tab are also selected.

9. Flip the design (Camera View) over so that you are looking at the l_g@ i Eii I_I

bottom of the board (using the Rotate command) and add the ki~ =
‘Conductive Pattern’ filter to the active set.

10. Select any part of the large copper area and notice that it
is selected along with all the routing patterns.

11. Change the Camera view to A-Side Isometric using the
tool bar icon.

12. Click the Select Net tool bar icon on the right side of the
graphics panel. This will change the Control panel to the
[Nets] tab.

13. Select the net AGND. Select nets $73 and then $72.

%~ BoardModeler Lite - [BasicOperations]
P Fle Project View PCB Lbrary Tools Window Help

Dad;msa ] @@@@@@lﬁi@\zﬁﬁa\%%l@@@@l%@\&ﬂ

filets tab

b
lx x

FEIpg ye =

Select Net 2>

mlmlulm'mlalmlnlv

History Panel

E BasicOperations.

| For Help, press F1 [Selected folder - _Instances

Tip: Change the Rendering of Parts to Transparent or Hide to make is easier to see net objects.

Data transferred from CADSTAR into the BML design, such as silkscreen and placement outlines, are
actually part of the component footprint and are not separately selectable items themselves (i.e. they
cannot be selected by clicking on them in the graphics panel). However, it is possible to view these items
and control the visibility of them by turning on or off the relevant layer in BML. This is explained further in
the following section.

End of Task.

\ M ZUKEN
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“H Viewing by Layer
BoardModeler is a layer based application with links to 3D objects. Each Layer is a 3D object in itself.
This section will help you to see the layers that are imported from the host CAD system. The CADSTAR

Layer names are listed in the Control Panel — Layers tab. The Layers tab controls both the layers’ visibility
and color.

icDperations

-Ii"l

Note: All layer colors can be

changed except BOARD_FIGURE. Lavers |Parts I Mechanical partsl MNets I WS I
Fendering of parts: Default ;I

iew | gﬁ;agg an wire I Side
1 +  Top Plagchaded ut Top Elec
2 + Top Asg I#;igan:gm ut Top Elec
3| & Top silk HaltEEe | Top Elec
4 4"  Top Solder Reszist Mazkine Top Elec
P | & [Top Elec Conductor  A-side
fi +"  Bottom Elec Conductor  B-gide
i 4"  Bottom Solder Resist| Maskine Bottom Elec
4 4"  Bottom =ilk Sy mbol Battom Elec
q 4"  Bottom Aszzembly Keep-inout Bottom Elec
10 4"  Bottom Placement Keep-insout Baottom Elec
11 + BOARD_FIGURE Board Laver irrelevant
12 4"  Haole Haole Tranzparent

MZUKEN
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Task 4 — Viewing by Layer

1. Click the Layers tab in the Control Panel

2. Change the Graphical view using the Isometric view icon.

MZUKEN

3. Tick each box in the View column to make the layers visible as in the image shown below,

Ti Clicki th Vi | Layers | Parts | Mechanical parts | MNets | wes | Default ;I
1p: ICKIN e ilew column
P 9 ] I Rendering of parts: | Default - | Default
header button will turn all layers Shaded :
on and off simultaneousl! Layer vien | _Tyoe il ESide Sha.je.j o e
Y- 1 |Top Placement " Keeparea  Top Elec _EI &
_ Wireframe
2 |Top =ilk "  Symbol Top Elec Trarsnarent
3 |Top Elec & Conductor  A-side
4 |Baottom Elec ~  Conductor  B-side © eesmyp o
5 |Bottom silk "  Symbol Battom Elec -
6 |Bottom Placement| “ FKeep area  Bottom Elec -
7 |BoARD FIGURE | &7 Board Layer irrelevantq
P |Hole ~ _ Hale Transparent

4. From the Rendering of parts: drop-down list
box, select the Hide option to hide all the
components in the design. You should end up
with a screen similar to that shown >

In the Layers tab of the Control Panel you should
notice that there is a ‘tick’ in the View column for
every layer listed as shown above.

Contral Panel

5. Experiment by turning or ticking layers on and

Layers IParts | Mechanical partsl Nets | WiGS |

off to see the appearance in the graphical e of parts: T
window. Wiew | Lawer Twpe Side Color
1
2
6. Clear all the ticks except for the ‘BOARD + v e
FIGURE’ and ‘Top silk’ layers. 5 |
f
[ 7
Lel
e
7. Try changing the color of Top silk to white. This & = {EORRD FIBURE Pemm——
should be the result... > [ 12 ] .

Note: When creating closed component outlines in
CADSTAR, BML will interpret them as filled.

To avoid this, change any closed shapes in your
PCB components to Open. They will appear as
shown.

End of Task.

2N
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Controlling the Display of Individual Parts

By using a combination of the operations we have learned up to now, it is also possible to have different
display settings for individual components (parts) within the design.

First set the display so that all components are visible again (from the drop-down list box at the top of the
Control Panel — select the ‘Default’ option). Now select capacitor C2 in the design (using any of the methods
from above) and press the right mouse button. A pop-up menu will appear.

Select
Move

Default

Shaded on wire sl model

Shaded Collision check

v Fit to selection
Recenter

Assodate shape...
Replace with Library...

Predision level 3
Delete

Filtering 3
PCB shared...
Property...

For the moment, ignore all the other options and select View to show the additional menu. Select the
‘Transparent’ option from the menu and observe the result. (As shown above)

Note that only component C2 is affected. Try assigning different options to other components and see that
you can combine different viewing options (rendering modes) on a per component basis.

You can also apply individual rendering modes to the board and conductive patterns etc., allowing views of
the design such as that shown below to be created.

\ M ZUKEN
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I’|ﬂ:] Task 5 — Controlling the Display of Individual Parts

From the Control Panel [Layers] tab, select the ‘Default option for Rendering of parts.

Select capacitor C2 in the design (using any of the
methods from above) and press the right mouse
button. A pop-up menu will appear.

For the moment, ignore all the other options. Using
the Right Mouse Button, select the View
—>‘Transparent option and observe the result.

Note: only component C2 is affected.

4.

Try assigning different options to other components
and note that you can combine different viewing
options (rendering modes) on a per component basis.

Select the Board shape and apply individual rendering
mode such as transparent.

Select the conductive metal patterns,

Zoom in for a unique viewing perspective.

Default

Shaded on wire
Shaded
Wireframe

End of Task

22
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Selack
Mave

Open selected model

Collision check

Fit to selection
Recenter

Assodiate shape...
Replace with Library...
Predision level

Delete

Filtering

PCB shared...

Property...
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Preparing BML for use with a CADSTAR Layer Stack

In order to setup a proper CADSTAR to BML relationship for seamless collaboration, we need to provide
BML with some information about a default CADSTAR layer stack. This will allow us to start a design
within BML, importing a board outline and a placement height limitation area which we can then transfer
back to CADSTAR. To do this we need to know which layer should be associated with the height
limitation area.

ol =l
In the Project Browser, switch to the [EDA I/F] tab. You will see Assembly | L'F F |

the layers defined which match the layer-stack for the current Categary : [PGE Layers -
design.
Max. conductive layers : |2 =
Laver name L# | Hool
Simply select Apply button. This will update the configuration for Ul e 17
BML and allow it to use this layer data as a default when a new 2 |Top Assembly 15 "y
project is created locally within BML (without passing any design 3 |Top Paste 7 v
data from CADSTAR first). This process will become clear in the 4 |Tap =ilk 11 ~
next section of the tutorial. 5 |Top Solder Resist 19 o
£ |Top Elec & ol
7 |Bottom Elec ] ol
2 |Bottom Solder Resist 20 ol
9 |Bottom =ilk 12 ol
10 |Bottom Paste 2z ol
17 |Bottom Aezembly 16 il
12 |Bottom Placement 14 ol
13 |Top Elec_PLAGEMENT 24 ol
14 |Bottom Elec_PLACEMENT |20 e
15 |BOARD_FIGURE a1 el
16 |Hole L3 2 v

K1 2

Add... | Remove | |

| Hide removed layers

Load PCE |Elasic:0peratiu:un3 ﬂ
fpply | Rezet |

MZUKEN
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H} Task 6 - Working with Design Data

Now that we have become familiar with some of the basic operations of BML, we can move on to working
with design data. In the next section we will import a board outline into BML — which we have
theoretically received from the MCAD department, set up the origin of the board and finally load this data
into a new CADSTAR design which only contains the unplaced components as a result of passing a
design forward from CADSTAR schematics.

We will also see how placement changes can be made in BML and back-annotated into CADSTAR and
how we can choose how components are modelled and displayed within BML (from simple extruded
‘boxes’ to complex, true 3D models).

Starting a new PCB Design

Fle Project View Lbrary Tools Window Help

1. If you still have BML running then select
File>Close>Project. (you don’'t need to s a x
save it), otherwise select All Programs->  ‘=ilws|marrinrr
BoardModeler Lite->BoardModeler from
the Windows Start menu to run it up again.

Creating new project ﬂ

Praject Location : IC:\BML Training'Bt"_Praject

BasicOperations bma

I

For Help, press F1
_

2. We are going to create a new BML project called
‘Tutorial’. Select File 2New 2>Project and enter ‘Tutorial’
in the Creating new project dialog.

Project Filsname : ITutoriaI

oK I Cancel

3. In the Project Browser click the right mouse button on the Assembly folder and select New PCB from
the popup menu. Enter ‘Tutorial’ again as the name of the PCB.

Assembly | Library | EDA I/F | IDF I/F | Xl| Assembly | Library | EDA I/F | IDF UFi

Tutorial List of existing PCE : Tutorial
-t i -] Assembly
MNew PCB... Fjg ] _Documert

Mode property... +-J Tutorial

FCE name : ITutoriaIl

ak, I Cancel

The Project Browser tree will update to show the new contents of the project.

\ M ZUKEN
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Importing a Mechanical file

4. We will now import the board outline to be used for this  assembly | Library | EDALF | DFIF|
design from a STEP format file supplied to us by the [& Tutarial
MCAD department. = Asserbly

T

5. Right-click on the Tutorial PCB folder in the Project

Browser and select Mechanical file>Import... from the CADSTAR v
popup menus. [Alternatively, ensure the Tutorial PCB IbF '
ji ]
folder is selected in the Project Browser and then use the Mechanical e Lo
File >Mechanical file 2Import... menul]. Delete
For the next dialog you must tell BM how to support the =

mechanical file that is about to be imported. It is either an & fssembly File  Part File
Assembly File or a Part File. Since the file contains more than
one part it is an Assembly file.

Cancel I

Note: it is important to request this type of data from your MCAD system. 'Assembly' is a STEP
structuring level and should be understood by most/all MCAD systems that support STEP
import/export.

6. Browse to the C:\BML Training\BM\_Library\_Constraint folder in the Open dialog and select the
‘BoardOutlineStart.stp’ file.

Copen x|
A > -
euv| .. =BM - _Library - _Constraint - ml Search _Constraint
Organize *  MNew folder = - [ @
a N -
¢ Favorites Name | Date modified
PR Desktop n BoardOutlineStart. stp 3/4/2011 4:32PM I
Download: "
4 Downloads M| CaseBottom.stp 3/4/2011 4:32PM

1l Recent Places
= M| CaseTop.stp 3f4/2011 432 FM

. o Modi e, :
4 Libraries M| ModifiedBoardOutiine. stp 3/4/2011 4:32PM
@ Documents

J’ Music

[ Pictures

E Videos

it% Homegroup
- =l | o)

File pame: |BoardOutlineStart.stp j ISTEP file (*.stp;* step) j

Open |v| Cancel |

7

The STP file is converted to an ACIS file which is
native to the 3D kernel being used. Upon completion,
a report dialog will be displayed. If the dialog
contains any output you can open the report to review
it or else select [Close]

The file will be imported and the display should look
similar to the image shown.

| Decimal coun th = @~

AS you can See’ we have not Only |mported the board T Name lmzin|ui|:nn;ev:nmnuIlnsemnamelsme Parts origin | Local Axie |Dm; |DmyD |nnzm|
outline shape, but two pre-placed components and an 2 e v e o — T O
| ¢ |led-dia03000254)@LED2| ¥ Unknown - 2950000 675,000 0.000

additional shape that represents a height limitation

\ M ZUKEN
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We now need to do a small amount of set-up so that BML knows how to interpret these different items of
data.

7. In the table at the bottom of the Graphics Panel, for the first item, set the Element kind to be ‘Board’.
The Instance name will be automatically set to BOARD. [Note that you may need to either press the
Enter key or click in the Instance name field after selecting the Element kind from the drop-down

menu
MName Impart | Element kind | In=tan
# | BOARD ol
2 | Top Elec_ PLACEMEMNT ol Eart iy
o eep-inSout

3 | led-dial300(02540@ L EDT| Heigtit limit

4 | led-dial2000254@LED2| «+  HERER
Document

1| Mazking
Conductor

8. Set the remaining entries in the table to match those shown in the image below.

MName Import I Element kind I Inztance name I Side | Parts origin
1 |poaRD v Eoard BOARD
2 |Top Elec PLAGEMENT | &  Height limit  Top Elec PLAG. = =
2 |led-dia02000254@LEDT| & Part LEDT 5 e
P | led-dianzonizsaelEn2| v Part LED2 5 e [

Setting the Origin

Now all that remains to be done is to set the origin for the board. We
are going to locate it at the bottom left-hand corner (seen when looking
down on the board from directly above).

9. From the 3D Model Toolbar select the Move Origin icon and lﬁ this will display the standard

move ‘manipulator’ in the Graphics Panel.

This could be used to move the origin interactively by dragging it. In this case, we will specify the exact
location where we want the origin to be as the intersection of two sides of the board.

Note: the pre-placed components and height restriction area @ | Position [439.50¢ [493.50( [2.000 IF'.r

will not be displayed during this process).
play 9 P ) 'I_Ee-nter of geometries
v Intersection of two edges
rt | Elemn

I Mormal vector to the face
Cross vector of the two edges r Boar

10. From the tool bar icon at the bottom of the Graphics

Panel( tool tip: Ways to specify the origin, select the Perpendicular to face center ¥ Heigt
Intersection of two edges option. > T[T OETS TS # Part
b |led-dial300(0264)@LED2| &  Part

\ M ZUKEN
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11. In turn, select the two edges of the board which intersect at the bottom left-hand corner.

Once the second edge has been selected the origin will be moved to the intersection point.

12. Finally, select the bottom icon from the 3D Model Toolbar to accept all the
changes we have made and ‘register’ this information in the project.

Register to Project

h-:' BoardModeler Lite - [Tutorial] — IEIlil
§F Fle Project View PCB Lbrary Tools Window Help _|E||£|
Neédd oo ar| | sde|LEEN e eumrns: oE
Project Browser o x | Control Panel ’E
Assembly | Library | EDA IF | IDF L/F | Layers | Parts | Mechanical pat] > i
M BazicOperations Fenderine of parts: IDefauIt f
EH_] Assembly -
{7 _Document Wiew | Layer (=
§B BasicOperations | 1 | & Top Elec PLAGEMENT @
Elﬂ Tutarial b | + |BOARD FIGURE et
-] Substrate
B Layers =
m-_] Ihstances oz
H L
B-_] Parts
#{C] Constraint
| =] Tutarial
.| =] Report{Mecha Import)
« e rEtersn 85
| Measurement History Panel |
"’ Tutorial
For Help, press F1 |Select madel. “
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ZH importing BML data into CADSTAR

Project Browser

Assembly | Library | EDA I/F | IDF F | Layers | P

We have now prepared the board outline shape with the
required origin and are ready to export this data for use in
CADSTAR Design Editor.

M BazicOperations Rendering o
B Assembly -
{1 _Documert iz
P BazicOperations ol

V

1. Right-click on the Tutorial PCB folder and select Em_ﬁ Gpen FEB

CADSTAR - Export... from the pop-up menu. - —
BN CrosTaR 3
IDF ¥

Mechanical file

2. Set the following paths for the RIF and RINF files in x|
the CADSTAR Export dialog and then select [OK]

FIF path : |Training'\E.~'-‘«DST.-’-‘«F|\SeIfTeach'\TutnriaI.rif‘ |

C:\BML Training\CADSTAR\Self Teach\Tutorial.rif FINF path - [raining\CADGTAR\Gel Teach'Tutarialfis . |
C:\BML Training\CADSTAR\Self Teach\Tutorial.frs
0]4 I Cancel |

Make sure you include the correct file extensions
(.rif and .frs) in the names.

3. Select File 2Exit and then choose Yes when prompted to save the data and quit BML.

NOTE: If BML was run up from the Tools menu in CADSTAR you will be now be prompted to reload
changes into the CADSTAR design. Select No, and close the design without saving.

4. Ifitis not already running, start CADSTAR and load the ‘Tutorial’ workspace (‘C:\BML Training-
\CADSTAR\Self Teach\Tutorial.csw’). The display should look similar to that shown below.

¥ Tutorial - Tutorial.pch (C:\BML Training\CADSTAR\Self Teach)) - PCB Gold - Zuken CADSTAR _ ol x|

I File Edit Wiew Add Actions Settings Libraries Tools Window Help

NeES| 4 BRX o ~|{imS orau -EEEREE A RARREA&
NiGematbnagioe - FOOTRABENTLL X 2 %% % Blownrs |
|<1 M start Pag%m Tutorial.pcb x] B

]

=-_3 Open Designs
... 18 Tutorial.pcb {C:\BML Training\CADST|

I EJ

salpadold adeyg @l

I

4| | »
[@ Design Rule Errors l [ Routing Completion l
Ready |[300.5 4179 II |[Thou [[Grid:5.0 | |

MZUKEN
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5. Select the File=>Import... menu option and

set the format to be P.R.Editor XR Files.

4

r Irport File
‘USE .the. ,[BI'O\.NSG] button - to Se|(?Ct the C:ABML TraininghCaDs. ATutorial. ri Browse...
Tutorial.rif file from the C:\BML
Training\CADSTAR\Self Teach’ folder. Format: | PRE ditor 4 Files =] Aot |
CADIF
. . CADSTAR 7 (for DOS] PCE Binam Earmat Help |
Do not change any other settings and simply CADSTAR 7 [for DOS] PCE Initial Data
DxF
select [OK]. ~ Mapping IOF
OrCA0 PCE' Netlist B
FCE Archive [puiEe. |
FREditor R Filez :
I~ Use|PRE ditor %R HS Files Edit tap... |
RIMNF Metlist

=) Create Mew Design % herge into Current Design

QK I Cancel | Help I

The board outline and height limitation area shapes from BML will be imported into the CADSTAR
PCB design.

6. Repeat the same File=>Import. process but this time set the Format to be RINF Netlist and use the
Browse button to select the ‘Tutorial.frs’ file from the ‘C:\BML Training\CADSTAR\Self Teach’ folder.

The two pre-placed components (LED1 and
LED2) will be positioned in the correct location
on the board.

7. To quickly place the remaining components on
the board and for the purposes of this tutorial,
import the RINF file StartPlacement.frs from
the C:\BML Training\CADSTAR\Self Teach
location.

8. Using the same process which we used earlier in the ‘Basic Operations’ section of the tutorial,
transfer this design to BoardModeler Lite. This will be used in the next Tutorial section.

Note: When creating a new PCB design using Mechanical data files, the CADSTAR PCB design must
exist containing the parts. This process will not import P.R.Editor XR file into a new CADSTAR PCB
Design unless a netlist is present.

End of Task
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Changing How Parts are Displayed in 3D

Your design in BML may look similar to the image shown if you chose
to use the Top Placement layer component shapes. The default 3D
view of the components on the board is a very simple representation,
created by extruding the shape drawn on the placement layer (in the
PCB footprint) in CADSTAR to a defined height. The height of each
component can be specified either by adding an attribute to the part
definition in the CADSTAR library, or by setting the height directly in
the component footprint. In this tutorial, we have used the second of
these two methods.

However, this simple representation may not be accurate enough for our needs (for example to check for
collisions between components and a system case or chassis) and we may have more detailed 3D models
available for some or all the components we are using in our design.

With BML it is very easy to replace the simple representation with a
more detailed 3D model and also to switch between the different
representations as required.

Many parts vendors, such as manufacturers of connectors,, will
supply their 3D CAD data on their website in either STEP or ACIS file
format.

From BML 5.2 onward you will have access to the 3D Parts Library
Wizard.

An objective at this stage is to collect the critical 3D part geometries and store them in a safe place.
This is commonly located in the BM Installed DOCUMENT folder.

For this Tutorial we have provided you with some higher details shapes in a project structure in place.
See “C:\BM Training\BM\Library”

) Mechanical enclosures — ltems used for collision checks — BML Tutorial data
. _Constraint
. Pparts_1 Lowest level of parts detail
BML Tutorial 3D Parts are stored here. _
, _Parts_2 || cep-dia055-0200.5at
. Parts 3 | | dio-04500185-do35-1016.zat
| _Parts_4 || led-dia0300-0254.sat
|| res-0/000250-mrs25-1270.5at
, _Parts_5
. . || TESTPOINT-con-soldereye-010,sat
, Parts_6 Highest level of Parts detail
|| to9d.sat

\ M ZUKEN
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“2DH Task 7 - Changing How Parts are Displayed in 3D

1. Select one of the transistor components (TR1 or TR2) in the design and Celack
click the right mouse button. From the assist menu select the Replace Move
with Library... option. View .
Open selected model
2. In the dialog that now appears, ensure that the Library Path field is set Coliision cheds
to “Level 2" and select the Replace button. Fit to selection
Click [Yes] to confirm that the dialog should be closed. _ter
Assodate shape...
You should now notice that the simple representation for the selected R N C T
transistor has been replaced by a more detailed model. Predision level r
Delete
® Replace part with library shape X Filtering .
PGE name : W Library folder : m PCB ﬁ"larEd. -

Status of replacement 141 parts PTDpEft‘j". -
TR1 - 10592 .. OK

cv

Replacing shape of part X

9 Part shape replacement successfully cormpleted.
\TX Do you want to close the dialog?

Yes I Mo |

‘ Click

I~ Prior shared shape replacement

[~ Update eraphics concurrently

Check. Library | Replaci Clle Cloze

3. Now repeat the same process with a few more of the components
in the design.

Once you have done that, select one of the components with a
detailed 3D model and then click the right mouse button. From
the resulting pop-up menu select Precision level and then Level
You will notice that the displayed representation for the
component has now returned to the default, simple
representation.

Select

Move
View 3
Open selected model

Collsion check
Fit to selection
Recenter
Assodiate shape. ..
Replace with Library...

Unkowr

Level 1

v Level 2
Level 3

Level 4 PCE shared...
LevelS Property...
s T
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You can also select multiple components (using <Shift >+ click or by drawing a selection box round the
components) and set the precision level for all selected components in one operation.

Selech

Move

View

Cpen seleched mode]

Collision chedk

Fit to selection
Recenter

Assoriake shape,
Replace with Library...
Predision level

Delete

Filtering

PCB shared...
Property...

It is possible to make the display of the detailed 3D models the default option when the design is passed
from CADSTAR to BML and we will see that in operation very shortly.

The relationship between the components used in the design and the detailed 3D models is handled
automatically based on 1 of 4 methods

1. the ‘Reference’ and ‘Alternate’ names defined for the parts used within CADSTAR matches the
name of the 3D model.

2. The Part name in CADSTAR matches the name of the 3D Model

3. A user attributed such as “3D_model” is added in the CADSTAR Part library or just with in the
local design attributes.

4. Using an XLS file that can be referenced by BML

If we take the diodes (D1, D2) as an example, in CADSTAR (using Item Properties) you can see that the
reference is ‘dio-04500185 * and the alternate is ‘do35-1016 ‘. Based on this, BML will look for a 3D
model to represent this part with the following name: dio-04500185-do35-1016.sat.

This mapping can be seen on the Parts tab of the Control Panel in BML, in the Library ID column — as
shown below.

— Component Definition D etailz
=iz |d|u-D4EDD‘I 5 L[~erz Farts | Mechanical parts | Mets | W3S |
Alenale: | 0351016 Fel | G | Shape [ Device | Library ID
Library Path: | 1 IR *  res-07000250(mrs25.. 470E-MRSZ5-1%  res-07000250-mrs25-1270
Height 228 Tr |2 |R2 res-07000250(mrs25. 39K-MRS25-1%  res-07000250-mrs25-1270
DesinVerson: 1 3 R4 res—0T0002500mrs25. 39K-MRS25-1%  res-07000250-mrs25-1270
Frpertes s 4 Rz res-07000250(mre25.. 470E-MRS26-1%  res-070002560-mrs25-1270
5 |1 *  dio-04500185(do35-1.. THE14 dio-045001 85-do35-101F
7 'DE dia-04500185(do5-1. 1Ma14 dio—04500185-da35-1016

Item properties in CADSTAR

Control Panel in BML

32
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The file name for the 3D model is built by combining the reference name with the alternate name,
separated by a hyphen. The ‘.sat’ file extension is added automatically. If, as in the case for the
transistors, the alternate name is blank, the name of the 3D model simply becomes the CADSTAR
reference name (t092.sat).

rep-dial55-0200.sat
SAT File
BB

dio-04500185-do35-1016.5at
SAT File

If you use Windows Explorer and navigate to .

the folder at

led-diz0300-0254.sat res-07000250-mrs25-1270.5at

SaT File SaT File
.. . 26 KB 14 KB
{x}:\BML Training\BM\_Library\ Parts_2
- - - TESTPOIMT-con-soldereye-010.5at to92.5at
SAT File SAT File
22 KB 1,044 kB

You can see the 3D model files used for this
tutorial design.

Note: For existing CADSTAR 3D users, BML provides a very simple and straightforward way of
converting any existing 3D model libraries into a form suitable for use with BML]. See Appendix - A

Now that we have seen how to change the representation for individual components interactively within
BML, let’'s look at how to have the detailed 3D models displayed by default when the design is passed
from CADSTAR to BML.

4. Exit from BML (File 2Exit) and return to CADSTAR — there is no need to save the project.

5. Select Tools >BoardModeler... to pass the design to BML again in the same way as previously —
but we now need to change the settings on the CADSTAR Import dialog.

Make sure the settings are as shown in the image — specifying that we want to use the representation
from the BoardModeler library at precision level ‘Level 2’.

CADSTAR Import x|

CPA& path : IC:\BML Training' CADSTARASelf Teach\Tutonal. cpa _I

¥ Update EDA LFF

Gieometry layer : ITOD Flacemert

— Peplace eeometry of components

’rSimpIe part shape generation

= Dan't replace
+ With Library of BoardModeler

Precizion level: |Level 1

eight attribute :

30 Model Name
Level 6
Library ID : i+ Component Hame

" Part Name

" Attribute I

¥ Import pads

—Simplification

v Import inner lavers

Conductive : ISD Shape 'I

v Import netlist
v Import tracks

v Import copper items

[~ Set board thickness : IED.DDD thau

QK I Cancel
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When the design is loaded into BML the detailed 3D models
will be used immediately.

You may switch back to the simple precision for individual
components in exactly the same way as described above.

As an alternative to using the combination of the reference
name and alternate name to form the name of the detailed 3D
models, it is possible to configure BML to use the part name
instead. To use this option, ensure that the relevant 3D
models are named correctly based on the CADSTAR part
names (e.g. ‘1N9714.sat’) and select the Part name option for
the Library ID: field on the CADSTAR Import dialog.

Another alternative is to create an Attribute of Components in the CADSTAR Parts Library or within the
For those 3D models specified in the attribute value

local attributes of the PCB design (Shown below).

MZUKEN

CADSTAR Import

CPA path : IE:\BML Training CADSTARS elf Teach\Tutorial.cpa

¥ Update EDA IFF

’rSimple part shape generation

ITop Placement

Geometry layer :

—Replace geometry of components

" Don't replace

+ Wiith Library of BoardModeler
Precision level : ILeveI 2 j

Height attribute : I

30 Model Mame

Library ID : " Component Name { Reference+Alternate )

 Attribute

—Simplification

¥ Impart pads

¥ Import inner layers

Conductive : ISD Shape 'l

¥ Impart netlist
¥ Import tracks

[¥ Import copper items

[~ Set board thickness : IED.UDD thou

0K I Cancel

they will automatically be used when the 3D Model Name — Library ID: is set to Attribute.

Attribute Editor

Components | Pins | MNets | Part Defintions I Component Definttion | Test Poirts |

Name ‘ 30_model assembly_name thm_power_diss placement
c1 cep-dial55-0200
c2 cep-dial55-0200
D1 dio-04500185-do35
D2 dio-04500185-do35

LED1 led-dial300-0254

LEDZ led-dia0300-0254

R1 res-07000250-mrs2|
R2 res-07000250-mrs2|
R3 res-07000250-mrs2|
R4 res-07000250-mrs2|
TR1 to92
TR2 [to82
End of task
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Eﬂ Task 8 - Moving Parts in 3D and Collision Checking

Now that we have our design in 3D, we can investigate how to change the component placement by
moving components in the 3D environment. During this process we can also perform on-line ‘collision
checks’ to make sure that we are not causing errors in the design.

We will also investigate the use of the ‘measure’ functionality to measure sizes and distances and the
‘clearance’ tool which allows us to identify all objects which lie within a specified clearance distance of a
selected component or other design item.

Finally we will see that having changed the component placement, the new component positions are

back-annotated to CADSTAR to update the 2D PCB design.

1. Start by selecting capacitor C1 and then chose the ‘Move’ icon from the
3D Model Toolbar. @

You will see movement ‘manipulator’ appear, at the components origin.

Selecting and dragging on the red, green or blue-coloured arrows (if
visible) will move the component, but it will be constrained to move only
in the direction of the axis you have chosen (corresponding to the arrow).

The component can be rotated by clicking on the blue circular-shaped
arrows located at the top of the manipulator. The top control (with only
an arrow at one end of the arc) will rotate the component through 180
degrees, whereas the lower control (separate arcs with an arrow on
each one) will rotate through 90 degrees.

It is possible to disable the grab handles in the Z-axis. (i.e to lift items
off the board). This setting is located in the Tools >Options[Other]
tab. If you did not select this option, then you will also see a third, blue
arrow forming the Z-axis part of the manipulator

— Maoves Blign

I Do not allow partz to be moved oft the board surtace
Lin the Z-axis)

[T GCheck if parts are moved outside of the board outline

Note: Z-axis movement is not back annotated to CADSTAR as a height change. However it will affect
the clearance measurements in BML which may not be valid.

2. Before we move the component, select the icon at the bottom of the graphics panel to Synchronize

Collision Check.
\ M ZUKEN
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Now click and drag on the small black cross with 4 arrows and move the component so \}
that it lies somewhere within the height limitation area and then release it.

Notice that the height limitation area and the component has turned red and that an entry has
appeared in the ‘Collision’ table. This shows that component C1 is now in error against the height
limit area associated with the Top_Elec_ PLACEMENT layer.

Measure] Clearance Collision ]

| Refl | Element | Ref2 Element
Click |Part Tap Elec PLAGEMENT Height limit

%

Correct this error by moving the component (in the same way as before) until it is clear of the height
limit area, or we could simply use the Reset icon (from the bottom of the graphics panel) to
immediately return it «n  toits original location.

Experiment with these controls to see how they work until you are comfortable with their operation.
You can always Reset the component position at any time or use the Undo/Redo icons to step
backwards and forwards through individual move operations. Note that you can select multiple
components (using ‘Shift’ click etc.) and move them together in one operation.

Components may be swapped to the other side of the board using the Reverse icon (located at the
bottom of the graphics panel) and component positions and rotations can be set by typing in exact
values in the input fields (again, at the bottom of the graphics panel).

Enter position and rotation values Reverse

ZE » | position 151355176222 [-0M6 | anele 1800 | Mmoo (B g < o o

As you move the components, you should notice that for every ‘collision’ error that you cause, a line
will be added into the Collision table below the graphics panel. If you click on any of these table
rows, the corresponding items, which are involved in the collision, will be highlighted on the display.

Measure | Glearance GCollision ]

Refl | Element | Ref2 | Element
1 |WCooy Part AGND Part
[ b o2 [Top Elec PLAGEMENT]Height limit
3 £ Click 2art R1 Part

4 )‘ Part 1 Part

\ M ZUKEN
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Detailed highlight

5. To make a finer detailed identification of the

colliding surfaces, click the Collision item row in Focus
question, then click the <R.M.B.> and select Delete selected
Detailed Highlight Delete all

6. Once you have finished experimenting and you have a modified placement, save the project and exit
from BML to go back to CADSTAR Design Editor.

x|

7. You will be asked to verify that you want to re-build the Py
'@' Rebuild Board Modeler results into layout ?

results of the changes made in BML, back into
CADSTAR. Select Yes, and notice that the placement
of the components in CADSTAR has changed to match
that set up in BML.

End of Task
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Task 9 - Measuring Distances and Checking Clearances

Eﬂ In this section we will investigate the use of the ‘measure’ functionality to measure sizes
and distances and the ‘clearance’ tool which allows us to identify all objects which lie within
a specified clearance distance of a selected component or other design item.

1. Load the ‘3D Enclosure’ workspace into CADSTAR Design Editor
((‘3D Enclosure.csw’ from the ‘C:\BML Training\CADSTAR\Self
Teach’ folder).

2. Transfer this design to BML in the usual way — select the option
to use the detailed 3D models in the CADSTAR Import dialog
(set the Precision level option to “Level 2”).

3. Zoom/rotate the display onto the two testpoint components.

4. Select the Measure tool from the 3D model toolbar and select the two
testpoints, one after the other.

The minimum distance between the two components is measured, an
entry is added to the Measure table (below the graphics panel) and a red
line is drawn on the display to indicate this minimum distance.

Measure ICIearance | Gollision |

Distance | Refl | Ret2 | x1 | w1 [ 21| x2 | w2 | 22| Lerd | Lervr | Lenz | Time |
P [iooooo  fvocov AGND 200000 §75.000 0.000 400.000 §75.000 0000 100000 0000 0000 105848 N

If you change the view of the display (zoom, rotate, etc.) then simply clicking on the entry in the table will
draw the measurement line again. If you have multiples entries in the Measure table, then clicking on the
required table row will show the corresponding measurement line.

If we do not want to simply know the minimum distance between objects, but perhaps the distance
between two specific points or surfaces on the components, then we can also use the Measure tool to do
this.

v Elerment

d
5. Select the Level for shape icon (at the bottom of the graphicsl panel) and set Boct

the value to “Geometry”

6. Now select the face shown, towards the
top of the first testpoint component.

7. Rotate the display so that you can see the
parallel face on the second testpoint and
select the face (notice that it will highlight
individually).

\ M ZUKEN
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Measure |Olearance | Gallizion |

Distance | Refl | Ret2 | s | w1 | 20 | =2 | w28 | 22 | Len¥ | Lenv | LenZ | Time |

1 100000 WGoOW AGHD 200.000 875000 0000 400000 875000 0000 100000 0000 0000 10:5842

» 120000 IVOOQV AGND 260.000 840000 265,600 440000 340000 265600 180000 0000 0000 11:02:40

8. Continue to Experiment with the Measure tool to become familiar with the operation.

Let’'s now move on to look at the Clearance tool.

9. Switch to a top view of the board so it is easy to see the measurements.

10. Select the Clearance icon from the 3D model toolbar and select component C1 in the

11.

From the toolbar at the bottom of the graphics window, select the
‘min’ icon. This will measure the distance from C1 to the next nearest
component — or in other words, the minimum clearance. In this case,
that is component C2.

The distance is shown as before with the red measure line on the
graphics display and an entry is added into the Clearance table.

k-

The distance between these two faces is measured and shown on the display and in an entry in the
Measure table.

With the Level for shape option set to “Geometry”, it is possible to measure distances between
different points on the same component in addition to distances between components.

-

Clearance IEI.EIEIEI

Yl
=l

% Click

¢

Meazure Clearance IOu:uIIisiu:unl

Diztance | Refl I EIementIF{ef2|EIement| %1 I w1 I z1 I %2 I w2 I z2 ILen}{I Len‘r’l LenZI

A6.556 C1 Part 1043772 5071.780 400,000 1090:305 501.780 400,000 46536 0,000 0000

MZUKEN
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12. Now, ensure that C1 is still selected, and enter a value of “150.0” Clearance (I 50000
into the Clearance field. This time select the ‘Val’ icon and BML will
find all components (or other objects) which are closer than this
specified clearance distance to component C1.

For each object identified, a row will be added to the Clearance table. In this example case there
should be 5 rows in the table. Click on each row in turn to see the corresponding red measure line
displayed on the design.

Measure Clearance lGDIIiSiDn]
Distai:@e Fefl | Element | Ref? | Element %] v z1 w2 w2 z2 Len¥ | LenY | LenZ
,T 1043772 |501.7800|62171 (1090308 |501.780 [62171 |46.536 (00000 0.000
2 48620 Gl Part TRZ  Part Q26,780 390308 335936 924178 341758 335936 2602 48550 0000
3 land7? Gl Part R4 Part 831168 464918 65000 758660 430000 65000 Y2507 349158 0000
4 Hr4g60 o Part TR1  Part 1015636 574.819 146960 1097717 668620 146960 82081 93810 0000
5 M40 o Part n] Part 804813 602396 66736 BE2605 740528 66736 42118 138132 0000

13. Continue to experiment the Measure and Clearance tools until you are comfortable with their operation.

14. Choose the Select icon from the 3D model toolbar, or press the Esc key on the keyboard to cancel the Measure
or Clearance tool and switch back to the 3D isometric view.

End of Task
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2l Task 10 - Replacing the Board Outline
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Even after the PCB design has progressed to an advanced stage (e.g. placed and routed), it may still be
found necessary to change the shape of the board (for example, to accommodate more components or

to fit the PCB into a modified casing, etc.).

This can be achieved very simply within BML and the new board outline shape can be back-annotated to

CADSTAR Design Editor to update the 2D design.

We can see how that is done in the following operations.

Adjust the display of the design to
show it as a Top view.

From the Main menu, select the PCB > Substrate - Associate board... option. In the file window,

browse to the ‘C:\BML Training\BM\_Library\_Constraint’ folder and select the file called

‘ModifiedBoardOutline.stp’.

C:\BML Training\BM\_Library\ Constraint -0 x
B
%c | |~ BMLTraining ~ BM ~ Library ~ Constraint v 23 | search _constraint
Fle Edit View Tools Help
Organize v  Indudeinlbrary v  Sharewith v Burm  MNew folder == - Eﬂ @
S0 Favorites BEE ©
Bl Desktop || BoardoutiineStart. stp
L Dowrloads || Casing_Base - Aligned.sat
“‘.._—_l Recent Places )
|| Casing_Base.sat
M Desktop || Casing_Top - Aligned.sat
- Libraries || Casing_Top.sat
@ Documents I'—' ModifiedBoardOutiine. stp I
J’ Music
|5 Pictures >4 |
“ 6 items
o
. P . Copying the raw data ll
BML will warn that a board outline is already associated

with the design and ask for confirmation that it should be
replaced. Select OK from this dialog.

Another file has already been assodated.
Do you allow to overwrite it?

| x|

41
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3. The new board shape will be imported
and will replace the original one. The
display should now look like this.

4. Save the project and exit from BML,
returning to CADSTAR Design Editor.
You will be prompted to import the
design changes from BML. Select OK
from the dialog. The modified board
outline is imported into the PCB design.

Before - After

Note: As simple as this task is, it is not always easy to re-align a new board shape. In most real world
cases the board shape is coming from the master MCAD design where the origin is placed somewhere
other than what was translated from CADSTAR. In this tutorial it is easy to visualize that the original
Board shape we imported may been modified by the same user so we would not expect any extra effort.

Tip: Import the replacement board
shape as a temporary constraint shape
for initial inspection. If the New MCAD
board shape does not align with the one
imported from CADSTAR, it is
recommended that it be returned to the
MCAD user for adjustment.

Tip: BML will allow you to create a 3D
Library part where the new board shape
can be imported and aligned in the
desired orientation. Once aligned it can
be exported as .STP file and then
associated to replace the original Board
shape.

End of Task
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Adding Mechanical Enclosures

The ability to import a true 3D

Top Elee

Botiom Elec
Battom sik
Battom Assembly
Bottom Placement

] ) Pef|es | EEEfH e $EE AR E | History [PRI £ Constaint [Casing_Top - Aigned [2)) @ FinalPlacement A

enclosure is the ultimate e [ e s [ D [

. . Rendering of parts: [Default 4

comparison using the PCB Eerm—] =T -
Top Placement Keep

Designers placement scheme B s @

op si iy mt =

o

%

[zl

Top Elec_PLAGEMEN.
BOARD_FIGURE

RGO
H

In this section we will go
through the process of
importing a mechanical
enclosure (or ‘constraint’ in
BML terminology) into the
design, correctly positioning it
relative to the electronic data
(i,e. the PCB) and running
collision checks to make sure

‘ spllFesrareexe 85

the board and the components
fit in the case correctly.

In an earlier section we used the on-line collision checking function which is provided as part of the Move
command. That approach could be used just as well here, but to explore more of BML'’s functionality, we
will use the batch Collision check option this time.

We will use the Align tool to locate the imported mechanical data in the correct position in relation to the
PCB data.

Unfortunately, it is not common for PCB Design and MCAD design to have a coincident origin. This is
one area in the world of advanced EM collaboration that is still evolving. However with BML we can
stream line the process and still save a lot time.

Importing an enclosure can be made easier by first placing an additional ‘local’ origin (a WCS or ‘working
co-ordinate system’) on the BML PCB design. This is not strictly necessary in this case and we could
achieve the alignment operation without the additional WCS, but in a more complex situation it is a
method that may simplify things considerably.

\ M ZUKEN
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%=} Task 11 — Adding Mechanical Enclosures

Before we actually import the enclosure, we are going to add an additional, ‘local’ origin to the board,
which will help us in the alignment process. Make sure that the ‘Board’ and ‘WCS’ selection filters are
active before we start.

M@ R EY TR Ma -

1. Identify the hole in the board nearest to component LED1 (in the
bottom left corner when looking from the top of the board). Flip the
board over so that you are looking at this hole in the bottom of the
board.

2. Either select the Add WCS icon from the 3D Model Toolbar or select
the PCB > Add WCS menu option.

3. From the icon at the bottom left of the graphics panel make sure
that the option is set to ‘center of geometry’ and then select the edge
of the hole on the bottom surface of the board.

g~ | position [0000 000

center of geometry
v center of arc

A pale-coloured orgin marker will be drawn at the position where the WCS
will be added. In this case, it should be at the centre of the hole. However,
the z-axis in pointing in the opposite direction to the one we want.

4. Select the icon at the bottom of the graphics panel to reverse the direction
of the z-axis.

Rl s |
:I LFReverse E—axisl:

5. Complete the operation by confirming that the WCS should be added at
this position by selecting the Do operation icon (at the bottom of the

graphics panel).

The WCS will then be drawn in the normal, solid red, blue and green
colours to show that it has been successfully added.

\ M ZUKEN
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6. You can now flip the PCB back again so that it is the correct way up. Choose the Select icon from the 3D model
toolbar or press the ‘Esc’ key to cancel the Add WCS command.

Now we can add the mechanical case to the design and align it in the correct position.

7. Either select the PCB / Constraint / Add constraint... menu option or ..... |
right-click on the ‘_Constraint’ folder in the Project Browser and select =0 Library [

Add constraint....

==
{:l _hstances

MNode property...
11

8. Cpen the file browser in the Add Constraint Shape dialog, navigate to the ‘C:\BML Training\BM\_Library\

_Constraint’ folder and select ‘Casing_Base.stp’.

BML will then convert this STEP format file into a, ACIS
‘.sat’ file (‘Casing_Base.sat') and the dialog will remain
displayed allowing you to confirm that this file should
be imported.

Select OK from the dialog.

'u C:\BML Training\BM\_Library\_Constraint

%V I . C:\BML Training\BM'_Library'_Constraint

Add Constraint Shape x|

File path : IE:'\BML Training4Br*_Libran,_ConstrainthC

Shape name : |Oasing_Elase

Extengzion : zat

Frecizion : | Urik o ;I

Clearance : |[I.UEI[I thou

The display should now look similar
to this (zoom out a little if necessary).

File Edit Wiew Tools Help

Organize *  Incudeinlibrary *  Sharewith * Burn  Ng

|| BoardOutlineStart.stp
o h e w mm w o o
L CESinG Basl-ste_
|| Casing_Top.stp
|| ModifiedBoardOutline.stp

9. Select the tool bar button for Mechanical part.

W Exm 86
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10. Use the Move function to
flip the part 180 degrees
and slightly away from the
PCB data as shown.

Hint:use the manipulator
and click the red 180 arrow.

11. Select the Align tool from the 3D model toolbar and ensure that the Element e I - @
kind option (at the bottom of the graphics panel) is set to “Constraint”.

12. Set the Coordinate system option to be ‘Center of

MZUKEN

-

Component

& -

geometries’ and rotate the design so that you can see inside

the case and can see the locating pins where the board is going to sit.

13. Click on the case once to select it and then click on the face of the
locating pin that the bottom of the board will locate against. See the
imagea below to make sure you get the correct surface.

le point of edge
Intersection

Position of geometry %
Origin af model

14. Now change the Coordinate system option to ‘Origin of model’ and select

the WCS orgin, in the middle of the locating hole in the board, that we

added earlier.

46
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Intersection

Center of geometries
Position of geometry
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A white ‘ghost’ image will now be shown to indicate where the case will be moved to and a straight
line is drawn joining the origin point selected on the case with the WCS origin selected —i.e. where
the select point on the case will end up after the Align operation is complete.

15. Select the Do operation a. icon (at the bottom of the graphics panel) to confirm and execute

the operation.

16. You can now try to add the top of the case into the
design yourself. The data can be found in the file
called ‘Casing_Top.stp’ which is located in the
‘C:\BML Training\BM\_Library\_Constraint’ folder.

As a hint, set the Coordinate system option to
‘Vertex’ and select appropriate corners on the top and
bottom of the case to align them together.

n C:\BML Training\BM'_Library\_Constraint

aﬁvl . C:\BML Training'\BM'_Library\_Constraint

File Edit View Tools Help
Organize *  Indudeinlibrary *  Sharewith + Burn  Ne

| |BoardOutlineStart.stp

|| Casing_Base.stp
[ Teisra iy 7
__|ModifiedBoardQutline.stp
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Casing_Top added as a constraint and moved to avoid 3D overlapping.

17. Select the Align tool from the 3D model toolbar and ensure that the Element kind option (at the
bottom of the graphics panel) is set to “Constraint’. |

Middle point of edge

Intersection

Center of geometries
Position of geometry
Crigin of model

18. Set the Coordinate system option to be ‘Vertex’ and click on the case lid
once to select it and then select the corner as shown (a small purple spot
will appear over the corner when the cursor is in the correct postion).

19. Select the corresponding
corner on the bottom of
the case (a small blue dot
will be shown) and confirm
the alignment with the Do
operation icon.

The top of the case will be
positioned correctly on top
of the bottom section

\ M ZUKEN
48


http://www.zuken.com/cadstar
http://www.zuken.com/
http://www.zuken.com/

\ M ZUKEN

Casing_Top aligned with Casing_Base with view of constraints set to transparent.

Reminder — You can use <CTRL>-+ <Left, Middle and Right> mouse buttons when
performing Align or measurement functions to zoom, pan, orbit

20. At this point it would be a good idea to save the project (File>Save—>Project). Once the project has
been saved with the imported mechanical data in place, then it will remain part of the project even if
the design is modified within CADSTAR Design Editor and passed forward again to BML.

However, for the operations we are now going to perform in the tutorial, the top of the case will only
get in the way. So, either hide the top, by selecting it and from the View option on the right-mouse
pop-up menu choose ‘No display’, or open the ‘_Constraint’ folder in the Project Browser, right-click
the ‘Case Top’ entry (the one with the ‘gearwheel icon) and select Delete from the pop-up menu.

End of Task
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"2l Task 12 - Running Batch Collision Checks

So that we can look at the operation of the batch collision check functions, for the purposes of the tutorial,
let's start by causing some deliberate errors between the components on the board and the mechanical
case.

1. Move component C1 so that it overlaps into the side Measure | Clearance Collision |

of the case and move the VCC9V Solder terminal so Refl | Element | Ref2 |  Element |
that it clashes with its nearest support pin on the b [vocoddpar eemaien Mee bl porte
enclosure base. This should result in a layout similar 2 |z Part CazeBottom Mechanical parts
to the following (the errors that have been created are

circled in red).

Now we can see if BML will detect these problems.

2. Click the Select icon from the 3D model

L Collision Check for All ®
toolbar to cancel any existing command. X

Mame : IFinaIPIacement Level : |PCE

—Combination of data type :
3. Select PCB->Collision check=>All... from ™ Somponent to Component
the menu and set the ‘Collision Check for I” Gomponent to HLA (Height Limitation Area)

- . ¥ Component to Mechanical Part/Chaszis
All" dialog options as shown. [~ Mechanical Part/Chassis to HLA

[~ Mechanical Part/Chassis to Board

For now we are just going to look for

o | going [T PEE to other PCE{Component + HLA + Board)
collisions between the components and the [ PGB to Chassis
casing.

| Start check l Cancel

4. Select the [Start check] button. All the items which are in error (the two components and the case
itself) will be highlighted in red on the display and there will be an entry added to the Collision table for
each individual error.

\ M ZUKEN
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Element

El

The bottom casing, C1 and VCC5V are in error. The LED models are red by design, they are not in error.

It is possible to combine all or any subset of the checks at the same time, as required. You can also use
the Measure and Clearance tools to check distances between the components or board and the
mechanical case.

The batch collision check can also be limited to selected objects — rather than the whole design.
5. Simply select the objects which you wish to check and use the PCB / Collision check / Selected Data

command.

6. Having tried out the commands, move the components back to their original positions to clear any
collisions.

End of Task
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Creating Detailed 3D Part Models

MZUKEN

Acquiring 3D part models can be very time consuming, especially when electronic parts manufactures do
However it is worth the search and even to

not provide 3D models for download via their web sites.
contact the Vendor for the actually 3D CAD model.

In the event of a failed WEB search, BoardModeler Lite provides a 3D component wizard which allows
detailed 3D representations of the components in your designs to be created quickly and easily — there is
no need to rely on a separate M-CAD department to supply this data. In fact this application can be used
by the M-CAD department to help with the critical parts selection process.

In BML this feature is referred to as the Create Part Model [l e oat oo g Er et
function. § File Project View PCB | Library Tools Help
J 0o i J |J (] Create part model. ..
BEEmLibrary made]
Add shape. ..
Azze bl ||;|-wilr | Fra 14F NG
x|
Search template
Part tvpe Packase tvpe Fin count
|Cannectar =| |Pin Header(Straieht) 2 Rows-2 | Cataloe | -
Search result
Template name | Pincount | & | &2 | D [ o1t [ oz [os [ op [ E [ E1 | E2 | |
P |CH-PHSD2E2-0010-00001 10 507874 507874 877.165 126772 126772 40606 {56906 G490 179.1%4 210630 63|
1| | i
Edit template
Dim. na... | Dim. val.. I =
b = 07874
D 2 a2 07874
D6
=5 05 2t 3 D 877165
= |=| EE’+|—+ . = ¢ |o1 126772
E-l_ uﬂulﬂu:ll:lu T _l %tp 5 |p2 126.772
O HG ML OB L —
T E1l | 6 |06 49605
i . 7 |op 155906
PR 8 |E B49606
4 9 et 179.134 | |
TL A=Az 10 ez 210630
1 I
ﬁET: r :; ES 599370
b " EP 259543
S el s
o, DF =
Model name  [GN-PHSD2B2-0010-00001
Library falder | Parts (Level &) =]

Size of figure |
- L

Compile | Close I

Note: This is a user selectable option during the installation of BoardModeler Lite and must be installed

for this section.
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N

2D Task 13 - Creating Detailed 3D Part Models

In this task you will learn how to use the Create Part Model function to generate detailed 3D models and we
will also consider the additional steps you may need to perform to prepare the models for use with your

CADSTAR designs inside BML.

This operation is part of the library management for BML and as such can be performed without any other

project data being loaded in the application.

So to begin this section, if you already have BML running close any open projects (File / Close / Project)

1. Start BML from the Windows Start menu or desktop icon

2. In the project browser, switch to the Library tab. You should

see a display similar to that shown >

3. Start the Create Part Model function either by selecting the
Library / Create part model... menu option or by selecting the ] Parts (Level 4)
Create part model... option from the RMB menu on one of the 5
six library folders (_Parts_1 to Parts_6). We have chosen to

use _Parts_3 for this example.

.7 BoardModeler Lite - [FinalPlacement:1]
EW File Project View PCB | Lbrary Tools Help

ErT TR

Create part model. ..
open Library: model
Lddishape. .

Bzzrmhle |1 beaee: | ERa 16E

4. The Create Part Model dialog will be displayed as shown

&~ BoardModeler Lite
File Project WView Lbrary Tools Help

10 &

Bl x|
Assembly [ EDA LF | IDF IF |

| Library

fzzembly  Library ] ED& IF l IOF I/F l

[ Library
[:] _Partz1
cl |

Create part model...

] Parts 4
] Parts 5 add shape. ..
[0 Parts6|  Reload shapes

Mode property...

Create part model x|

Search template
Part tvpe Packaee tvpe

Pin count

. | |

Search result

o D I

| Template name | Pin count |

Edit template

Size of figure |
Jid

I Dim. na.. I Dim.val...l

Model name I

Library folder [ Parts (Level 5] =l

Campile

| Cloze I
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Search template

5. First select the drop-down list in the top left of the dialog labelled Part Fart type
type. This allows us to select the type of part we wish to create a | =
. . . . Capacit
detailed model for (e.g. capacitor, resistor, IC, diode, etc., etc.). | S={gir-ci i
Diode t
) ) Delay line u
For this example, select ‘IC’ from the list. Fﬁe
Filter
G
Inductor [%
Having selected the part type, we can now go on and specify the giEi”am, =
particular package type that we require. Phata coupler
Photo transistor
Photo transceiver
Transiztor
f ‘ , . Ed|Resiztor
6. Select the Package type drop-down list and select ‘QFP’ from the list Regulator i
of package types. Fiela
Package type
. . o | [=| |
As an alternative to choosing the package type from this list, BGA =
. CEP | |
select the Catalog button and choose the required package type jgé% ot HoatSi)
. with HeatSinl
from the images shown. LGG fwith GND)
LCG 4 Sides
LCG Type 4 Sidez-2
LQOFP
PGA 3
Search template SFS 1
Part type Package type Pin count QFP 2 Sides %
I3 =] [oFe =] - SG-59
SC-61B
Search result SC-70
5C-72
B u
Package catalog I X ] Pin count ER:IP 2
2 S04
S0P
o 1 :
|34
] | =40
B 700144
BGA c5R P 7ag gg
220 EE = It is possible to filter the
;gg gg search results further by
M Q ” 7o selecting a specific number of
A 75|58 pins from the Pin count option.
| Cancel gg
a2
o4
100
104
112 ~

Whichever method is used, after making a selection the remainder of the dialog will be populated
with results of the available templates for the selected part and package types. For example, if we
select ‘168’ from the Pin Count list, the number of different options presented in the table will be
limited to only 5 entries.

\ M ZUKEN
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Create part model

Search template

Part type Packase tvpe Fin count
I = [orr =]  Gstake | [i6e -]
B R EE =
Template name | Pincount | & | &1 | a2 | o | o1l o2 oL [or| E | Ef B
P C-GFP-0162-00001 168 20500 02500 34000 280000 06750 06750 &1.2000 06500 220000 0678 0y
2 |IC-QFP-0168-00002 168 35600 0.1500 32000 25.0000 06750 06750 31.2000 06500 22.0000 067 }gg
3 |IG-QFP-0168-00003 168 3EE00 01500 32000 26.0000 06600 0600 31.2000 0E500 280000 060|112
4 |IC-QFP-0165-00004 168 35600 0.1500 32000 280000 06800 06800 31.2000 06500 22.0000 05% }gg
B |IC-QFP-0168-00005 168 35600 0.1500 32000 25.0000 06750 06750 31.2000 06500 23.0000 067§ 132
136
144
160
Pal
— 176
Edit template 184
— — , 196
AL I A AAL 208
L 216
L
- 5 - b 39500 it
B EQQQQQH = 2 a1 02500 a5f =
3 304 -
| = I il
1 |
= 2= ol | = 5 |pi 06750
% + % ] 6 |o2 0750
= = TeP 7 oL 1.2000
r | ¥E34E! i |op ]
ilitatililali ! ﬁpu g e 380000 —
10 |E1 06750
f i ¥ 11 |2 ETED
= AZ |4 12 |EL 1.2000
= \I\"L.':’ AlY 12 Irm nEcan ;I
_.4_ =
L B'i"; 1
i m =TFP=UTES- 00001
Library folder |_F‘arts (Level 5) ;I

Size of fizure |
Ll

Compile | Cloze I

n

The search results presented correspond to the number of standard templates for the selected package that
the Create Part Model wizard has defined.

The columns in the dimension associations table (with headings A, A1, A2, D etc.) correspond to the
values for the specific dimensions shown in the graphics window in the bottom left of the dialog. If one of
the rows in this tables gives the correct sizes required for the package, then you can simply select the

desired row.

Search result

| Template name | Pincount | &4 | A1 | a2 | 0 | m [ o2 | oo [or| E | B0 | E2 | EL |

2 |I-QFP-0168-00002 168

IC-0OF P-0163-00003 168

39500 0.2500 :3.4000 280000 0.6750 06750 31.2000 0.6500 28,0000 0.6750 06750 531.2000
35600 01500 32000 280000 06750 06750 21.2000 06500 280000 06750 06750 31.2000 C
35600 01500 3.2000 280000 0.6800 06800 31.2000 06500 280000 06800 0.6800 31.2000 C

35600 0.1500 3.2000 28.0000 06300 06800 31.2000 06500 28,0000 06300 0.6300 51.2000 Cf

3
4 JIC-QFP-0168-00004 168
5 |IG-QF P-0168-00005 168

35600 01500 32000 280000 0.6750 06750 31.2000 06500 230000 06750 0.6750 31.2000 C
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However, if none of these standard sizes matches your _ _
requirement, it is possible to specify custom sizes for the : | Dim. na.o D sl =l
dimensions in the panel at the bottom right of the dialog. = 21 ggggg
| 3 |ao 34000
4 D 280000
Simply enter the required sizes in the table. Note that you | 5 |m 06750
will need to make sure all the dimensions for the package are | 8 |pz 06750
consistent and do not conflict with each other. 7oL 51.2000
8 |op 06500
. . . LE 28.0000 fr
If you need to enlarge the image in the graphics panel to see 10 (g1 06750
all the dimensions clearly, use the ‘Size of figure’ slider at 1 | 0A750
the bottom of the window. 12 [eL 31.2000 ~|

Size of figure JI

7. For the purpose of this example, select one of the templates from the Search result table.

Model name  [15-QF P-0165-00004
8. Accept the default model name and libray folder

name shown in the dialog and select the Compile
button.

Library folder |_Parts_3 ﬂ

Compile | Cloze |

Create part model [; E

BML will compile the 3D model for the selected package, using
any customized dimension values and pin count, and confirm y e e e )

successful completion.

=
9. Exit the Create part model dialog with the Close button and fssembly Library ]EDH I/F | IDF I/F |
open the relevant folder in the Library tab of the Project =] Lbrary
Browser. You will see that the 3D model has been created and (] _Parts.1
added to the library. +-[] _Parts 2
=L Partz 3
##1 10-0F P-0165-00004 |
) ) . CIFar=1g
10. Select the new model in the _Parts_3 folder in the Library tab ] Parts 5
and from the RMB menu select the Open Library model option. ] Partz 6
The new model will be opened and displayed in the Library

Model editor graphics window.
As you can see, it is very easy to quickly create complex 3D

models and add them to the BML library!

11. Finally, select File/Close/Library model from the main menu
to exit from the 3D Library model editor.

End of Task
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“H Task 14 - Modifying Detailed 3D Part Models

In This task you will repeat the steps of task 12 to explore the Create Part Model wizard in more detail
and try generating detailed 3D models for different types of component packages.

Now that we know how to create detailed 3D models, we can look at the extra steps we may need to
perform to make those models ready for use in BML to represent the components in your CADSTAR
designs.

In order for the models to be useful, we need to make sure that the position of the origin and the
orientation of the component match between the definition of the 2D footprint in the CADSTAR library and
the definition of the 3D model in the BML library.

So, let's create an alternative representation for one of the components in our tutorial design and see
how to set up the required configuration (the 1N914 part).

By referencing the datasheet information below for this part and the existing CADSTAR PCB design, we
can determine that we need to create a model with the following basic dimensions:

Body diameter = 80 thou
Body length = 200 thou
Pin pitch = 400 thou
Lead diameter = 20 thou

1. Start off by making sure that you have BML running with the BasicOperations project loaded (transfer
the design from CADSTAR to BML if necessary).

2. Switch to the Library tab in the Project Browser in BML, select the _Parts_5 folder and from the RMB
menu select the Create Part model... menu option to launch the wizard as before.

3. Select a part type of ‘Diode’ and a package type of ‘General(Axial)’.

. Create part model 3
The Search result table will be < g =
. Search template
popu Iated W|th a range Of Part type Packaee type Fin count
. inde - ieneral (fxial) - Catal -
possible package templates. . L e =] _omie | L
Template name | Pincount [ & [a1 ] a2 [ D [ oP | E [ B0 [ E2 [ FD [ Fd [ L | Eﬁ‘
. . |_1_|Dp-Dix-0002-00001 2 114961 - 114961 247441 492126 114961 57480 57480 114961 31.890 0000 0.0
Since there is no tem plate | 2| D-Di-0002-00002 2 337008 - 337008 230061 402126 337000 166504 168504 S37.008 51575 0,000 0.0
. g . - poooalz |z00m0al-  |200000l275: BT 1 00,000 100,000 200,000 50,000 000aloc
matChlng the speC|f|cat|on, we 4_|D-Dix-0002-00004 2 78740 - 78740 94438 196850 78740 39370 39370 78740 15748 0000 00
|_5_|D-Dax-0002-00005 2 77063 - 77053 1771665 402126 77053 38076 38076 77053 10685 0000 00
can select a model template |_6_|D-Dix-0002-00006 2 94488 - 94488 114173 205276 94488 47244 47244 94488 22441 0000 00
where the diode body diameter 7 | D-Dx-0002-00007 2 106299 - 106200 198650 492126 106209 53150 53150 wszgglzaszz 0.000 TIL[
1 »
is 200 thou. Edit template
|| Dim.na. | Dim val. -~
» [a 200000
|2 b =
|3 [a2 200000
] 4o 375000
TV d 15 [op 668076
= + — | 6 |E 200.000
. [§] 7 e 100.000
We can quickly see that the rest - . o e 100000
. H | 9 |FD 200.000
of the dimensions do not — Dolre  soom0
exactly match the sizes we A AU 0000 7
) 12 |4 0000 B
want to use, so we need to edit =
the temp|ate and create a I Model name  [D-DAX-0002-00003
custom package. Library folder [ Parts & =1
Size of figure JI Campile | Gloze I
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Enter the custom dimensions in the dialog so that they [ Dim.ra.. | Dim. val. | B
H H H I A UL
match the values shown in the adjacent image. > > .
3 |AD 20000
L[] 200.000
Set the Model name and Library folder so that they ||-2{PF 400.000
. . i |E 20000
are also as shown in the image, then select the | £ 40000
Compile option. 4 |ga 40000
9 |FD 20000
10 |Fd 20000
11 L n.ooo
12 |d 20,000 |
. =l
Maodel name |dio—04500185—d035—1016
Library folder |_Parts {Level B) =]

Compile | Gloze I

In the same way as before, open the newly created 3D
model in the 3D Library editor window.

The result should be similar to that shown below.

Assembly Library | EDA L/F | IDF IFF |

[:] _Library
{:] _Partz 1
D _Parts 2
{:l _Parts 3
] Parts 4
=] Parts 5
e =rAn35=1 16k
{1 Parts||  Open Library modﬁl
Wove folder o 4

Delete

Mode property...

Now select the Move origin | e ” icon from the 3D model

toolbar to see where the origin is currently positioned. As you can

see, it is in the centre of the component body, not at pin 1 whe
need it to be.

We now know where to align the origin to make it match with the 2D

footprint origin defined in the CADSTAR library.

To help with this alignment we will superimpose a ‘part guide’
onto the 3D model window.

Switch to the Assembly tab in the Project Browser. Make
sure the _Parts folder is expanded and select the diode (dio-
04500185-d035-1016) from the list.

N

re we

Assembly | Library | EDA LF | IDF IFF |

M BazicCperations
=] Aszembly

{17 _Document

=-§# BasicOperations
----- D BazicOperations
[#-_] Substrate
=] Lavers
=] _Parts

=4 cep-dial55-0200

'|i‘lfl d jo="ARNM BR—d~2F=111 fi
- led  Load part
=4 reg Load part guide

“‘l'Lﬁl TE T LTEUTT T
B+ tod2
[+ Zuken Text

MZUKEN



http://www.zuken.com/cadstar
http://www.zuken.com/
http://www.zuken.com/

\ M ZUKEN

_ Load Part Guide N X|
9. Now, from the RMB menu select Load part guide. Select _ )
OK to accept the default footprint from the next dialog Footprint : | dio-04500185-do36-1016.A (FP-A)  ~ |
that is displayed. ok | Cancel |

Notice that two numbered, origin symbols have been added to
the display, marking the position of the component terminal
positions as defined in the CADSTAR footprint. -

10. Use the Front display icon to switch the view to a 2D
view of the front of the component. >

11. Select the Move origin | be” || icon again so that we can re-position the origin in the correct location.

Since we know that the pin-pitch of the component in our design is 400 thou and the orign is currently
positioned at the centre of the component, we know we need to move the origin by 200 thou in the x-axis
direction.

We could simply repositon the origin by dragging on the red arrow in the Move ‘manipulator’, but to
position it in exactly the correct location, the easiest way is to type the required shift into the number field
at the bottom of the graphics window.

12. Enter ‘200’ in x-axis box and press the Enter key. The display
will be updated to show the new origin location.

| pogition [200°  [0000 [0000 |

(Isometric view shown)

@M File  Project Wiew Library model Tools Help

13. Save the modified 3D model (File / Save / Library model)

| |

New ‘PO B AE||@ @

and exit from the 3D Library editor back to the main Geametry | Library

Cpen
=N-I}1
Close —

project window.

- v

Save Project Cir+s
Save 1o lbrary Library madel
30 model

Sl
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14. Adjust the graphics display so that you can see the two

diodes (D1, D2) in the design.

15. Select both diodes and from the RMB menu select the

‘Replace with library...” option.

Selech

Maove

View 3
mpen selecked model

Collision chedk

Fit to selection
Recenter
fssociabe shape, .,

Replace with Library...

MZUKEN

& Replace part with library shape I E

PCE name : IBasicOperations Library folder : ILeveI 5 - l

Statuz of replacement :

2/2 parts

Predision level r
Delete

Filtering 3
PCEB shared...

Property...

16. The Replace part with library shape dialog will
be displayed. Set the Library folder to ‘Level
5’ and select the Replace button and then
Close the dialog

The original models have now been replaced with
the new ones we have created.

[~ Prior shared shape replacement

[ Update eraphics concurrently

Check Library |

D2 - dio-04500185-do35-1016 .. OK
01 - dio-04500185-do35-1016 .. OF

Replace I Cloze

You should now be able to create suitable 3D models to match the components used in your own
designs and use them to replace the simple, extruded models generated by BML.

End of Task

60
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Task 15 - Setting colours in 3D models

After creating 3D models using the Create Part Model wizard, it is possible to change the colours which
are used in the models. The following steps demonstrate how to achieve this.

=
1. Open the model of the diode we created earlier in the tutorial Assembly Library | EDA IF | IDF IF |
into the Library Model editor. ] Library

S0 Parts
@] Parts 2
-] Parts 2
0] Parts 4
=] Parts 5
el
“0] Parts fi

Cpen Library model
Move folder 1o
Delets

2. Make sure that the Level for shape option (at the bottom Node property...
of the graphics window) is set to ‘Body’ and then click on 1
the part of the model for which you would like to set the
colour.

Lo
~|  Element
v Body |

Geometry =

3. From the Library model menu, select the Set body color... option. This will open a colour picker
dialog which will allow you to select the desired colour for the body.

Library model Tools Help
Undo edit
Redo edit 3

erification [y

Color

<

Select
Mave

Align

Move origin
Add WCS

Basic colors:

[V e

Create box
Create cylindsr
Create polygonal cylinder

Delete body
Set body colar. . “!

Load part...

11T THEEER _IE

17T EEEENET

Diefine Custom Colors »>

Cancel
s

Load part guide...
Lightening of Lead

4. Repeat the process as required to change the colour(s) of other parts of
the model, before saving it ( File / Save / Library model) back to the
library.

\ M ZUKEN
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This completes the interactive exercises which comprise the BoardModeler Lite tutorial.
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Appendix

Preparing CADSTAR designs for use with BoardModeler Lite

Please note: The remaining sections in this document are not intended to be part of the tutorial (i.e. you
do not need to follow any further steps or complete tasks). The information is presented as a reference
to assist in your future use of BML, when setting up your own designs for transfer from CADSTAR to 3D.

For a CADSTAR PCB design to be used successfully with BML, to obtain a meaningful representation in
3D, we need to ensure that suitable information is available within the CADSTAR data to define the
following:

e The height of the components mounted on the board

e The outline shape used by BML to create the simple representation of the components in 3D. This
shape is ‘extruded’ to the specified height

e The correct thickness and material for the electrical layers in the design

e Construction layers (e.g. laminate and pre-preg) to define the correct layer-stack for the design and a
material and thickness for these layers

In addition to the above, in order to pass a CADSTAR PCB design to BML, there must be a board outline
defined in the data — otherwise the transfer will fail. This board outline can easily be replaced later within
BML if required.

Specifying the Component Height
The component height may be passed to BML in a number of ways, as follows:

e As an attribute defined in the parts library with the default name of ‘height’
e As an attribute defined in the parts library with a user-defined name (e.g. ‘Height/Inches’)
e As a component property specified in each footprint symbol

If a component has height information specified as both an attribute on the part and as a property in the
footprint, BML will use the specified attribute in preference to the setting in the component footprint. The
height in the component footprint will only be used if there is no height attribute present.

Please also note that as attribute names in CADSTAR are not case-sensitive, attribute names such as
‘height’, ‘Height’ and ‘HEIGHT’ would all be considered to be the same attribute. You may still use
capitalisation of any letters to assist with readability if required.
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Specifying Height as a Part Attribute

MZUKEN

To specify the height as an attribute requires that the parts library is edited. First add an attribute
definition to the library, using either the default name (‘height’) or any other name if preferred. In the
example below we have used an attribute called ‘Height/Inches’.

Set the Attribute Usage value to ‘Part Definitions’.

User Attributes

Description Py Add...
Elec_Type

HeightComp
link. b anufacturer

link. Orline CADSTAR Datashe
link. UAL to manufacturers FDF
Package

SI_PART

Technalogy Used
thm_power_diss
Attribute Usage: | Part Defiritions v

User Attributes - Detail I

Attribute Mame:  Height/Inches

Attribute Usage: | [FERNEE e a6

Lok J

[ Cancel ] [ Help ]

Then for each part required, set the value of the attribute to the correct height for the part. You may also
decide to make the attribute ‘read only’ — but this is not necessary for BML to use the information

correctly.

The height may be specified together with a suitable units specified (e.g. 300thou in the example below),
or if no units are specified, the value will be interpreted in whatever the current design units are.

Companent | Symbals | Ping || Gate + Pin Swapping | Attibutes
Attribute Text |Head Only |T}lpe
Value 10uF Yes Symbal and Companent
Wattage Mo Spmbal and Compotient
Tolerance Mo Symbol and Component
|¥nltane 10 Te Su::: ::: E::::::]t
Height/Inches 300thou Yed Part Definitian
[Avarnabinty ™G ) i
Alternative Part Mo Symbol and Component

If you have used the default attribute name ‘height’, then this will be used automatically by BML and no
changes to the settings in the CADSTAR Import dialog are required (simply leave the Height attribute:

field empty).

However, if you have decided to use a different attribute name (e.g. ‘Height/Inches’ etc.) then in the
CADSTAR Import dialog you must specify the name of the attribute which you would like BML to use.
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Specifying Height in the Component Footprint

The alternative approach is to specify the height as a ‘component property’ in the footprint symbol. To set
this up, select the required component in the design and open it for editing (select Edit Component from
the right mouse button menu or from the main Libraries menu).

Deselect All

v Move F2
[B Edit Companent X 1] |
7 EditPart bg

Link: On-line CADSTAR Datasheet

& atribute... f

Once the component has been opened for edit, the height can be set on the Component Properties
dialog ( File / Component Properties... ). Enter the value in the units specified. You will need to re-load
the footprint symbol into the design for any changes to be reflected in the design.

Component Properties E
Diesign Title | Component Properties | Companent Atributes |
Mamne
Reference Mame: |[H5gatEls
Alemate Mame: | 0200
@ Component © dumper Item Properties - Component b ﬁ
&b Component D etails Component/Part Feplace Mode
Mame: [ (%) Keep Existing
() Replace
Blecie Fasition: % |1200.0 () Relaad From Libran
e B v |550.0 HeloadP.inLabeIs.
Fieload Library Attributes
Height: | 3337 Thou Orientation: 270.0 B Remove Other Attributes
[] Fived Process
[ Mirrored (%) Selection
Fitted (O Wwhole Design
Browse...
Component Definition Details
E Reference:
Alternate:
Library Path: |{Self Teach Libran}spch lib
Although this value cannot be changed subsequently in | Height 2937 Thou T
the design (i.e. it can only be modified by editing the Design Versiorr 1
footprint symbol again), it can be viewed on the Iltem Wi Yiewtan 1
Properties dialog for the component. > Part Details
REI=
Mumber:
Description: | 10uF 100 Electrolytic Capacitor
Library Path: | 15elf Teach Library}Parts.lib
Diesign VYersion: 1
Library Y ersion: 1
[ QK. ] [ Cancel ] [Attributes...] [ More... ] [ Help ]
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Specifying the Component Outline Shape

To create the default, simple 3D view of components in the design, BML will use a single shape to create
a 2D outline, to which it will then add the specified component height (as outlined above), to create the
3D representation.

Users may specify the CADSTAR layer name that the Simple 3D shapes can be read from. l.e. Top
Placement, top Silk, Top Assembly, etc., on the CADSTAR Import dialog as the design is passed forward
from CADSTAR to BML.

CADSTAR Import x|

CPA path: IE:HEML TrainingsCADS TARYS el Teach B azicOperations. .. |

¥ Update EDE LFE

Gegmetr}f |a}.-er : ap Placement

’rSimple part zhape generation

The image below shows the tutorial design in CADSTAR with only the Top Placement layer visible (since
there are no components placed on the bottom of the board).

It is possible to use a different layer (other than the placement layer) to define the outline which BML wiill
use to generate the simple 3D representation for the components. This can be achieved under the
following conditions:

e There must be a closed shape on the chosen layer to represent the component outline.
e The layer chosen must be a non-electrical layer.
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As an example, let's assume that we have added a new non-electrical layer called ‘3D Model Shape’
which will contain the component outlines which we want BML to use.

TOp PTOTITg FTated FOM-EECTeal [TOmE] T Mo SW UM
Top Profiling Mon-Plated Mon-Electrical (Mone) 1 (Mo Sw Untl
Top Placement Mon-Electrical Placement 1 Bottom Untl
3D Model Shape MNon-Electrical {MNone) 1 (Mo Sw Untl
TOD AScemony 1§ [s]4 B -Toai g1 RESEmoy T BoTon ntl
Top Glue Spot MNon-Electrical {MNone) 1 Bottom Untl

To configure BML to use this new layer, we need to specify the correct layer name on the CADSTAR
Import dialog when the design is passed forward to BML.

CADSTAR Import A ——

CPA path - IC:\EIMLTraining'\,CADSTAF’i\SelfTeau:h'\,Elasic:Opera‘ |

[v Update EDA I/F

Simple part shape 2eneration
(Geametw laver - | 20 Model Shape]

Note that once the design has been loaded into BML, it is possible to see which layer has been specified
under Conversion Parameters on the EDA I/F tab of the Project Browser.

Simple part shape 2eneration
3D Model Shar v |

Froject Browser Primary laver
Assembly | Library EDA I/F |IDF I/F |

Secondary laver ;I

Category : |PCE Lavers |

2rS

inn Parame
i

Top Assembly
Top Glue St
Top silk

Bottom silk
Bottom Glug Spot
Bottom Assembly
Bottom Placement

ters
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Specifying a 3D model using an attribute in the CADSTAR Parts Library

CADSTAR Import x|

CPA path - |C:\BML Training CADSTARSelf Teach\FinaIPIacement.c;I

It is possible to specify the preferred 3D model name
to be associated to a CADSTAR Part by using an

K ¥ Update EDA IF
attribute.

’rSimpIe part shape generatioh

Geometry layer : ITOD Placement

Create a new attribute in your CADSTAR Parts

Library I.E. 3D_Model_name. [ Replace geometiy of components
i Don't replace

* With Library of BoardModeler

Enter the 3D shape file name that exists in the Precision level : [Loval 2 -
preferred Precision level. l.e. Level 2 of the
BM/_Library folder structure. Height atiribute : |

— 30 Model Name
Enter the Attribute name in the empty field in the 3D Libtary 1I0: " Component Name { ReferencetAltemate )
Model Name section of the import dialog. ® Ft (s

& Attribute I3D_mode|_name
—Simplification

¥ Import pads

[¥ Import inner layers

Conductive : ISD Shape 'I

¥ Import netlist
[V Import tracks

¥ Import copper items

[ Set board thickness : |ED.DDU thol

CK I Cancel
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Adding Construction Layers to the Design Layer-stack

The layer-stack for the design used in this tutorial is only a simple, double-sided board. Even so, for it to
be represented correctly in 3D within BML it is necessary to define the core laminate layer and assign it
the correct thickness. The same applies to the top and bottom electrical (conductor layers). The image
below shows data from the CADSTAR Layers dialog showing the layers and their thicknesses.

Marme Description Type Sub Type Physical Layer | Swap Layet| Fouting Biaz | Thickness (Thou) Material Embedding
Top Elec Electrical [MHone) 1 Bittam El H 0.7 Copper Foil Ahove
Laminatel Construction [Mone) (Mo Swea Unbiazed E3.0|FR4 Mone
Bottom Elec: Electrical [Mone) 2 Top Elec b 0.7 |Copper Foil Below
= o

Top Elec (0.7)

You should also set the correct ‘embedding’ for
the electrical layers.\

Laminatel (63.0)

Bottam Elec (0.7)

Blind Via | Lnavalzble Buried Via |Unavailahble
[#] &0l Layer Pairs Fit to \Window
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Materials for Electrical, Construction and Non-Electrical Layers

Although BML does not currently use the

N

MZUKEN

information regarding the actual materials used for

Material Details

each layer, this may change in the future and it is
good practice to set-up the design data so that it is
correct. Other tools in the CADSTAR suite (e.g. SI
Verify) do require this information to be specified in
order to function correctly.

For non-electrical layers (for example, solder mask
layers), it should be noted that unless a material is
assigned to the layer in CADSTAR, the layer
thickness will not be output into the CPA file and

therefore would not be available for use within
BML.

Materials may be defined or modified by selecting the
Materials button on the Layers dialog. If no suitable
pre-defined material exists in the list, select the Add
button to add a new one and enter the required values
on the Material Details dialog. Any new material
definitions added are saved with the CADSTAR design.

Materials need to be given a name and a type (e.g.
Construction, Electrical or Non-Electrical depending on
the type of layer they are to be associated with).
Depending on the type of the material, one or more of
the Permittivity, Loss Tangent and Resistivity values
must be specified.

b aterial:
Usze for Layer Type: | Construction
Permittivity: Electical
MHon-Electrical
Loszs Tangent; 0. 000000
Resigtivity: e-8 0%ma/m
[ 0k ] [ Cancel ] [ Help ]
Materials [

000-21 51

A4-PPE 5| Melco
Copper Foil
ELPEMER 2457
FR4

High Tg FR-4
Isola FR 408

M egtran
Megtron Y 1
Meloo 4000-13
Meleo 4000-13 51
Prepreg 2125
Prepreg 7628

Add
Delete

Details....

e

]

[V] Repot...

I Cloge l

[ Help ]
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Migrating 3D Libraries from CADSTAR 3D to BoardModeler Lite

Users of the previous 3D EM Collaboration tools

¢ CADSTAR 3D,
e EM Checker and
o EM Designer

who have a fully developed 3D Library, can easily migrate the legacy folder structure to be BoardModeler
(Lite) compliant.

: . . | BoardModeler Lite
To begin the legacy 3D models migration select Start> B 30 Librery Miaration

Programs >BoardModeler Lite - 3D Library Migration

ﬁ BoardModeler
, Document

The adjacent dialog will appear.

Bl LibraryCopy Tool =0lx]
Select the Source setting depending on TE e GER
the previous Zuken 3D applications, G
library folder. " EM Checker & CADSTAR 3D

. L. 3D Symbols Source Folder:
Specify the upper level folder containing

the 3D symbols IE:\demDs\SDsymbols J

~ Diestination

A default library folder location will be BiM Library Root Folder:

derived from the current BML settings in |CHBML TraininghBh Library J

TooIs/Optlons. Precision Lewel : ILeveI z "I

Click the Browse button to redirect the

3D Symbols Delimiter : I- 'I

¥ Copy Log

Choose the precision level folder of
where the legacy symbols will be copied.

CABML TrainingiBk_LibranACopyCADSTARID log J

Start Copy | Exit |

Click [Start Copy].. A progress indicator will appear as shown below.

Copying libraries [5%] ﬂ

IE:\demDS\SDsymeIS\CS1 206_0TANCE1206_01ASAB

\ M ZUKEN
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Upon completion the legacy folder and symbol name structure will be migrated into the BM(L) folder

structure as follows;

3D symbol folder names containing the actual symbol are migrated as

3d Folder name {delimiter} symbol name
Alternate name}

{Comp name -

-> _Parts_4

0.1_Molex_2P - \Vertical.sab - 0.1_Molex_2P-Vertical.sat
3D Symbol name
Comp name {No Alternate}
Soic16.sat - Soic16.sab

0.1 2 Molex || Vertical.sab

T Boivwe s [N

=
6_Ov| . = 30sy... = 0.1_Mole... hd m“ Search 0.1_Molex_2P @
File Edit View Tools Help
Crganize *  Incudeinlibrary =  Sharewith * Bumn =» == - m @
=1 || demos ﬂ Mame
= | 3Dsymbaols

| 14A094_F29F_AA ' C\BML -aining\BM\_Library\ Parts_4 = Ellﬂ
. 14AG50-FEZF-AA @_Ov - BML Training = BM » _Library ~ _Parts_4 - mj I Search _Parts_4 m‘
W 14sop Fle Edit View Help
by 18B314-FIVF-DA Organize v New folder = + 0 @
. 19A150-FBOF-AA
. ; =
| 20s0p ﬂ LI ¢ Favorites Name | Date modified | Type | I
1 tem B Desktop || 0.1 2P Molex-connect.sat 5/25/20118:33AM  SAT File
4 Downloads | 0.1_2°_Molex-test.cat 12/7/2001 5:21 AM  SAT File
=il Recent Places B 0. 1_Molex_2P-Vertical.sat 5/26/20118:33AM  SATFile
B Deskiop || 144094 _F29F_AA-FUSED1_ETM.sat 5/26/20118:33AM  SATFile
= Libraries || 14A650-F6ZF-AA-XSMDET. sat 5/26/20118:33AM  SATFile
@ Documents || 14sop-A_14sop.sat 5/26/2011 8:33 AM SAT File
& Music || 18B914-F5VF-DA-VRO 10,53t 5/26/20118:33AM  SAT File
58 H e
[E5] Pictures || 19A150-FBOF-AA-ANTO0S, sat 5/26/20118:33AM  SATFil -l
Videos
B sl | "n
0.1_Molex_2P-Vertical.sat Date modified: 5/26/2011 8:33 AM
fizsembly (L DA IF | IDF IF | = 0.1_Molex_2P-Vertical.sat Date modiied: 5/26/20118:
- SAT File Size: 24.1KB
[ Library = Date created: 5/26/20118:33 AM
{1 Parts (Level 1 (simple}

=+ _Parts {Level 2)

- cep—dial5E-0200

ﬂl dio—04500185-do35-1016
ﬁl led-dial300-0254

- res=07000250-mr=25-1270
- TESTPOINT-com-soldereye-0
ﬂ 1002

{1 Parts (Level 3}

B _Parts (Level 4

g 0.1_2P_Molex-connect

m 0.1_2P_Molex-test

ﬂl 0.1_Malex_2P-Vertical

m 0207-R-0207-R

g 0603wid-reflow

- 120612060001

A 1206-REFLOW

8 1 206-WaNE

ﬁl 144094 F29F_AA-FUSEDT ET
g 14AEE0-FEZF-AA-XSMDET
- dsop-A_l4zop

- 18B014-FEVF-DA-VROTD
m 19A4160-FEOF-AA-ANTOOD
- 194 150-FS0F-AA-ANT009.S:
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HZH Trimming Through Hole Part leads

When importing 3D models from vendors or using the 3D Part model wizard, it may be
necessary to alter through hole part lead lengths to replicate the final assembly length.

Do not worry about lead
lengths during the creation
stage. Long leaded part
models can be trimmed to fit
once they are in place.

Located in PCB 22Utilities = select Trim leads of parts..

This tool is used as virtual N 565
lead trim saw that will adjust
the lengths of all through hole Board thickness [12530 mm
leaded part models to meet Packaze mourt type : [CSMD [ Lead ¥ Unknown
real World aSSGmb|y Default protrude leneth II.EIIJIJEI mim
specifications. Package list
Package I Shape ;I
SpeCIfy the requ”'ed 4 FDED5—rEf|DW_IPG@R4 rIJEIJE—refInw_IPO
rotrusion lenath as shown=> 10 | z020-I-refl. zot 163- @02 z020-I-refl. zot 1631
p g 11 | 2=020-I-refl. got 163-1@03 z020-|-refl. sot163-1
12 | mec—cornermatker mec—corner mark.er
Select the parts to be trimmed 18 | mec-fiducial-dia0 12 mec-fiducial-dial 12
14 | mec—front-ed-lo mec—frant-e2-lo
15 | mec—holed30-non-plated mec—hole130-non-plated
Select the [OK] button. 16 | PLGC-68-reflow@Ll 1 PLGC- ff-reflow
17 | beafid-reflow beabd-reflow
. . P [con-euro-9f-aneled - Alpha-MNumeric@: | e gttt gt =Y W=t ol = W BT o)
_The reSUIt IS a mOdIerd |0ca| 19 | TESTPOIMT-con—soldereve-010@TF2 TESTPOIMT-con-soldereyve—-010 -
instance of the 3D part model _I'I< | V[
aSS|gned_to the parts in the ok | [ aeal |
PCB design.

Note: The actual library
model is not altered. To
return the part to its original
state, simply use the
“‘Replace with Library” ==

function. SR P

L
'l Ill'|l'll'|ll|1||

LR T

' | Ay Byl

g L 'I L I‘ L |I L |I ' |I I |I 'yt :
I -
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